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Abstract

This document is the User’s Guide and a
tutorial for a new version of the Persint
interactive detector and event visualiza-
tion program developed for the ATLAS
collaboration [1]. The program is well
suited for event scanning and for analyzing
complicated events in their most intricate
detail.
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History

Date Version Comments Persint version

30/10/2009 V-4.0.3 Draft version (incomplete) Persint-00-01-24

20/11/2009 V-4.0.4 Draft version (incomplete) Persint-00-01-29

17/12/2009 V-4.0.5 Draft version (incomplete) Persint-00-01-36

15/01/2010 V-4.1 First complete version Persint-00-01-41

19/03/2010 V-4.2 Computation of invariant masses Persint-00-01-46
+ minor corrections

09/04/2010 V-4.3 - Export as .ps and .pdf Persint-00-01-53
- New feature: Save Special. . . : Compare geometries
- Improved Captions

19/06/2010 V-4.3.1 - Study of geometry and material Persint-00-01-63
- Improved labels and captions
- Display vertices; 2 track shapes: ribbon, cylinder
- Display magnetic field map

19/08/2010 V-4.3.2 - A-lines (alignment) downloaded for each event Persint-00-01-68
- Histogram of d0 distribution
- Spinbox added for easy numerical settings

22/10/2010 V-4.3.3 - Modified interface with MuonBoy Persint-00-01-75
- Fully implement ”Preferences” menu
- Python script available in /Persint-00-02-••/example
for generating an OutMboyView file from ESDs
- Updated TRT description
- Download magnetic field maps from the Internet

29/01/2011 V-4.4 Direct access to User Manual Persint-00-01-83
Clean up field maps + Display Muonboy error messages
Histogram of integral

∫
Bdl

Full-screen mode + Edit color of selected volumes
Select particular sectors for display in an event

09/03/2011 V-4.5 Added 1D plots of magnetic field Persint-00-01-92
Redesign track selection user interface
Multi-user installation
Appendix B rewritten (Installation)
Optional disabling of Log console

15/04/2011 V-4.6 Selection of solenoidal field map Persint-00-01-98
Redesign Generate Muons window
1D plots of

∫
Bdl

14/10/2011 V-4.7 Added German and Italian versions of GUI Persint-00-02-27
Map of X0; map of ”expected number of stations”
Export map data as ASCII file; switch to/from Log scale
Additional AGDD/XML shapes

The pdf version of this manual can be found at:
https://twiki.cern.ch/twiki/pub/Atlas/Persint2Wiki/PERSINT2_Manual.pdf
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Introduction

Persint 1 is an interactive visualization program developed for ATLAS. The program has
been operational for many years and was used for:

- Designing the muon spectrometer
- Debugging the successive detector layouts, in particular resolving volume clashes

in the GeoModel
- Optimizing the reconstruction software
- Analysing cosmic ray data in the commissioning phase
- Analysing collision events (data and Monte Carlo)

The new version described in this manual retains all the functionalities of the original
package [2],[3] and features a modern graphic user interface (GUI) and an easy to use
file management system. The new interface, which uses the Qt library from Trolltech,
makes it easy to interact with objects or applications.
Persint has many remarkable features, which can be used to visualize events in their
most intricate detail. It is currently running on Linux , Mac OS and Windows operating
systems and is interfaced with ATHENA, the general framework for data analysis in
ATLAS. The package is being used with simulated events and with real data: cosmic
ray events and events from collisions.
Persint is particularly well suited for understanding complicated events, when the visual
representation of the detector’s response becomes crucial.

1 Main features of Persint

The Persint program is designed for the three-dimensional representation of objects. It
visualizes detector geometries using an interface with AMDB 2, an ASCII file containing
the primary numbers used to build the muon spectrometer geometry. It also accesses
AGDD 3, an XML-based geometry description language for the Atlas generic detector,
mainly concerned with the inert material in the spectrometer. Persint interfaces with a
variety of independent applications, in a fully interactive way. These applications include
visualization of active detectors, inactive material, and the magnetic field map, as well
as the detection of volume clashes, the display of event hits from files of physics events
(simulated or data). It is possible to display events reconstructed with any reconstruc-
tion program active in ATHENA. Furthermore it is also possible to interactively run the
embedded muon reconstruction program MuonBoy, and display the results.
For spatial navigation, one can set the desired perspective for the 3D-view and display
2D-projections along various axes (Fig. 1). It is possible to change the viewpoint in order
to best visualize the desired region, to displace the viewed objects with operations like
translation, rotation and zoom.

The remarkable features offered by Persint are:

- 3-dimentional representation of objects in full volumes or “wire mode” using the
computation of hidden faces

- Spatial navigation with real time displacements

- Focal length adjustment, from isometry to wide angle
1Persint: PERSpectively INTeractive
2Atlas Muon Data Base
3Atlas Generic Detector Description
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- Interfaces with numerous applications

- Display of magnetic field map; tracking in magnetic field of generated muons

- Displays can be exported as .png, .jpg, .bmp, or .svg files.

- Highlight of volume edges; adjustable light intensity on volume faces

- Detection of clashing volumes and highlight of intersections

- Boolean volume operations (addition, subtraction, intersection).

(a) 3D View

(b) 2D Z-View (c) 2D X-View

Figure 1: Various views of a Persint display
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2 Architecture

Persint has been in use since 1995 and is written in Fortran90 . The core code contains
everything needed to parse, store transiently and generate volumes from standard XML
files. Analytic calculations determine volumes with hidden faces, provide the detection
of clashes, can highlight volume intersections and supports boolean volume operations.

A second layer of C++ wraping classes provides the liaison between the core program
and the graphic interface. This layer is made of classes encapsulating the calls to Fortran
routines.

The third component is the Qt/C++ Graphic User Interface (GUI) .

Persint is a stand-alone package which uses ASCII event files as input:

1. The ASCII event files can be produced by ATHENA from raw data, with proper
setting of the “properties”. In this case, the full potential of Persint can be used,
including the interactive reconstruction of tracks with the embedded Muonboy re-
construction package. However, results from any ATHENA reconstruction package
can be chosen for display (Muonboy, Staco, Moore, Muid, . . . ) 1.

2. These ASCII files may also be produced from ESDs, using a “procedure” in
ATHENA (Appendix G.2). In this case, events can be displayed but the inter-
active reconstruction of tracks cannot be performed.

Details of the design architecture can be found in Appendix A and in [6].

3 Installation on supported platforms

The necessary total disk space for installing Persint is less than 200 Mbytes. The fol-
lowing platforms may be used:

• Persint is developed under Ubuntu Natty (11.04)/Maverick (10.10)/Lucid (10.04)
/Karmic (9.10)/Jaunty (9.04)/Intrepid (8.10)/Hardy (8.04 LTS) on 32- and 64-bit
platforms

• Persint runs under Scientific Linux 4/5, in particular on lxplus at CERN

• Persint runs with Mac OS: version ≥10.5.6

• Persint runs under Fedora 11 (Leonidas), 13 (Goddard) and 14 (Laughlin)

• Persint has been tested on Debian 5 (Lenny)

• Persint was succesfully installed under Cygwin 1.7, the Linux-like environment
for Windows 7

Detailed instructions for installation and requirements for dependencies are given in
Appendix B. An abridged HTML version of this user’s manual is available at:

https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki

Up to date information on releases, installation and dependencies can be found
there.

1Muonboy, Staco, Moore, Muid are computer programs for muon track reconstruction in Atlas.
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4 Starting Persint

• To start Persint under Linux, launch the program with the Persint icon on the
desktop 1.

• Under Mac OS, launch the Persint.app application placed in the Application folder
at installation time 2.

In the pop-up window, choose the language: English, French, German, or Italian.
Upon launching Persint, the default AMDB geometry file is loaded automatically. It
is located in the directory Persint-00-02-••/AmdcData/share, where Persint-00-02-•• is
the persint working directory 3

Then a window is displayed which prompts you
to restore (or not) the view which is automat-
ically saved when closing the previous session
(answer Y es or No).
When launching Persint for the very first
time (there is no “previous session”),
answer Y es in order to display the default
view (Zmumu4023.p2vf ) which is created
at installation time in the directory
Persint-00-02-••/example. a

aWhen running the preloaded Persint on lxplus at
CERN for the first time, there is no default view available.

Figure 2 shows this default display in which labels have been added to indicate the
location of the various tool bars and windows. The display also contains a simulated
di-muon event which has been superimposed. How this is done is explained in section 6.3.

It is always possible to retrieve the original view (or any view which was saved as a
.p2vf file). This is done in the following way:

Click on the Open view icon of the File tool bar. Select and open either the
default file Zmumu4023.p2vf 4, or any saved .p2vf file.

Open view. . .

• The program’s version number can be seen in the About item in the Help menu
(or in the persint menu in Mac OS). The latest version is Persint-00-02-27 5

1Under Linux, this icon is created on the desktop at installation time.
2Under Mac OS, an alias can be conveniently placed e.g. on the Desktop or in the Dock.

It can also be launched from the Terminal by typing ./start persint.sh in the persint working direc-
tory: Persint-00-02-••.

3Persint-00-02-•• is the evolving version number of Persint, e.g. Persint-00-02-27.
4Zmumu4023.p2vf is located in the Persint-00-02-••/example directory.
5Check for the latest version at: https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki.

As the version will evolve with time, the version number is given as Persint-00-02-•• in this document.
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5 The Graphic User Interface

Figure 2 shows the Persint window once the program has been launched.

5.1 Items of the Graphic User Interface

A detailed description of menus and tool bars available in the Graphic User Interface is
given in Appendix E.

• At the top are the menus: File , Image , Navigation , Volumes , Events ,

Tools , Window and Help . The persint menu is specific to Mac OS).
These menus give access to the various operations one can perform.

• The most common operations (but not all) are also available through Tool bars
which appear just below the menus, as repeatedly shown in Appendix E.
The user can choose which tool bars to display. A right-click on any displayed
tool bar will produce a pop-up list from which items can be enabled or disabled.

List of tool bars
The Navigation tool bar has been placed on the right hand side by the user. 1 It
has a number of functions (represented by icons) which allow changing the aspect
of the main display in many ways.

• The large window at the left, the Selector window, is used for selecting detector
volumes.

1. The AMDB interface allows interactive access to the geometrical data bases
of the amdb simrec type [4] and concerns not only detector volumes like muon
chambers, calorimeters and trackers, but also magnets, feet, and shielding.

2. The AGDD interface allows interactive access to data bases of the ATLAS
Generic Detector Description type [5] [9]. The AGDD interface is used to
display the inert material in ATLAS.

3. The Magnetic Field Interface provides a fully interactive 3D visualization of
the Magnetic Field. The use of this interface will be described in section 9.7.

• The detector and event Main display window occupies the largest area of the
display. When saving or exporting a view, it is the content of this main display
window which is saved.
The Main display can be modified in size by dragging the lower right corner. Also,
by right-clicking on the title bar of the window, a number of functions appear
in a pop-up window, which you are invited to test. 2

This Main display window can be made ”Full screen” by using the appropriate
item in the Window menu, or the short cut by typing the letter F (lower case). To
exit the full screen mode, type F again. Actions on Main

display

• Finally, the Log window can be opened in the Window menu (Appendix E.7) and
shows comments about the successive operations when running Persint.

5.2 Online help

The location on the screen and the size of all these windows may be changed by the
user. Online information about the functions of the icons is provided in an information
box which appears when the curser is positioned on any icon. Some examples are shown
in figure 3.

1Any tool bar can be placed to a preferred location by the user.
2This pop-up menu also appears when right-clicking on the title bar of the Histogram of hit

calorimeter cells window (section 11.3.3).
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(a) Data manager (b) Export (c) Previous view

(d) Volume indentification (e) Generic chamber description

(f) Partial wire mode (g) Z-halves selection

(h) Customized zoom (i) Navigation scale (j) Displaced volumes (k) Reload event

Figure 3: Examples of online information boxes, when positioning the curser over an
icon.

5.3 Speeding up Persint

When handling complicated event displays, the execution time of Persint can be signifi-
cantly reduced by disabling the Log console. This is achieved by checking the appropriate
box in the Preference pane of the Tools menu (Appendix E.6, page 143). For Mac OS,
the Preference pane is in the Persint menu (Appendix E.9, page 146).

5.4 Toolbars or Menus ?

In the following tutorial, we will mostly use the
tool bars, although using actions in the menus
may be preferred by some users.
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6 Exercise 1: Setting the stage

In this section, we will start using Persint and explore it’s most basic features as well
as the main functions proposed by the interface. It is assumed that the installation was
successful and that the necessary dependencies are satisfied (see Appendix B).

6.1 Necessary files

For proper initialization of certain applications, the program loads several databases
and input files. It is possible to load any database during running time, but it is of
interest to load default files, so that the program can initialize its applications when
they are launched for the first time. Default files are stored, at installation time, in the
Persint-00-02-•• directory .
This section (6.1) provides information about the files needed for running Persint, and
no action is needed at this time. You may however want to create two directories for
storing various files generated when operating Persint, for example:

The persint export files directory (or any other name) for storing files generated by the Export view
function of the File tool bar (see section 6.4, item 2). These are files for presentations and publi-
cations.

The persint working files directory (or any other name) for saving Persint-specific files. These are files

which you may want to save when interrupting your work until your next session with Persint.

6.1.1 Detector description and magnetic field

Persint uses several files which concern the detector description and the magnetic field
map . At installation time, they are placed in the directory Persint-00-02-•• 1 and
can be loaded by clicking on the Data manager icon of the File tool bar. In the pop-up
window (Fig. 4) load the necessary files as follows 2:

1. The AMDB file (of the amdb simrec.xxx type) from which the detector volume can be
displayed is loaded from the Volume tab (Fig. 4a). When clicking on

�� ��Load , the files in
the directory Persint-00-02-••/amdcData/share are made available. 3 For this tutorial,
we will load the Default file by clicking on

�� ��Load Default 4 and checking the box: ”Load
AGDD Volumes from the AMDB file”.
The two other buttons are used to

�� ��Reload the current AMDB file or
�� ��Define as Default

the Current file.

2. The magnetic field files are loaded from the Magnetic Field tab (Fig. 4b). Select
the Current map for both the muon spectrometer and the solenoid. When clicking on�� ��Select , the files in the directory Persint-00-02-••/BFieldData/share are made avail-
able. There are additional field maps, located in a CERN repository, available through the�� ��Download. . . button. Select the desired file in the Download extra field maps. . . win-

dow and click on
�� ��OK to transfer them into the Persint-00-02-••/BFieldData/share

directory.
For this tutorial, we will select the Default map for the muon spectrometer by clicking on�� ��Select Default Map 4 Finally, click on

�� ��Load .

The current map can be made the default map by clicking on
�� ��Modify default map .

1Created at installation time and named according to the Persint version in use. Check for the latest
version at: https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki

2When all the files are chosen, click on
�� ��Close window .

3The content of this directory is shown in Appendix D.2, Figure 110a.
4When running Persint on lxplus at CERN for the first time, there is no default map available.
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(a) Choosing AMDB and AGDD files

(b) Choosing the Magnetic Field file

(c) Choosing the Event file

Figure 4: Using the Data manager window for loading the necessary files.
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3. Event files are loaded from the Events tab (Fig. 4c). When clicking on
�� ��Load , the files

in the directory Persint-00-02-••/example are made available. Event files can be loaded
from other directories.
The bottom part of the window shows the Muonboy collision cards file, which is used
for the interactive reconstruction of tracks within Persint. Here again, the Default file was
chosen with

�� ��Load Default .

6.1.2 “Example” files for Event 4023

For the purpose of this exercise (Exercise 1), three more working files are placed in the
directory Persint-00-02-••/example 1 during installation of Persint. They concern
Event 4023 of a Z → µ+µ− simulation:

1. Zmumu4023.p2vf : Detector description file.

This file was produced to embed Event 4023 in a detector layout, and is
only an example. You may want to build and display your own “visible”
detector, save it as a .p2vf file and use it as a template for displaying
events.

2. Out.MboyView Zmumu4023: Event file.

This Event file is an ASCII file produced by ATHENA when the “prop-
erties” are properly set. It contains the event Zmumu4023 with all in-
formation necessary for viewing in Persint: parameters for hits, tracks,
calorimeter clusters, reconstruction, and simulation of this Monte Carlo
event.
Persint can also use event files produced from ESDs, as explained in
Appendix G.2.

3. Zmumu4023.p2ts: Track parameter file.

This file contains the track parameters applied to the event to be dis-
played. The file is produced within the Set track parameters window
where parameters such as momentum and energy thresholds, as well as
the color code are set (see section 6.3, item 6, and figure 6).

No action is required at this stage, except to check that these files are present in the
proper directory. All these files will be used in this tutorial as “Default files” .

6.2 Interfaces to applications

The Persint display window gives direct access to a series of applications through dedi-
cated interfaces. They will be described and used throughout this tutorial.

• the AMDB Interface

• the AGDD Interface

• the reconstruction and Event display Interface

• the Track parameters interface

• the Muon Track Generation Interface

• the Magnetic Field Interface
1The way to access these files will be explained as we go along.
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6.3 Displaying detector layouts and events (Exercise 1 starts here).

1. Start Persint (see section 4).

2. Clear the view in the main display.
Use the Clear icon in the Image tool bar and choose Clear view in the proposed
menu (or click directly on the “brush” in the icon). With this scrolling menu
one can make a selective clearing of AMDB or AGDD volumes, labels 1 captions or
pictures 2, event hits 3.

Clear
3. Display detector volumes.

The desired detector volumes can be displayed using the Selector window, the
operation of which will be detailed in sections 7.2. For the present exercise, we will
load the “Default file” which was prepared when studying the Zmumu4023 event:

Click on the Open view icon of the File tool bar. Choose and open the file

Open view. . .

Zmumu4023.p2vf in Persint-00-02-••/example of your working directory. The
detector volumes are displayed 4, as shown in figure 2.

4. Load a Z → µ+µ− event in the following way.

Click on the Data manager icon in the File tool bar. In the pop-up window, go
to the Events tab (Fig. 4c) and click on

�� ��Load Default to load the “Default
file” Out.MboyView Zmumu4023 which becomes the “Current file”. Close the
Data manager window.

The Event file contains information concerning the geometry to be used. In case
the current AMDB geometry file does not match the geometry used for the
current event, a warning is issued, which prompts you to load the expected
geometry file, as shown in figure 5. Answer

�� ��Yes to load the expected geom-

etry file. It is possible to answer
�� ��No , in case one wants to impose a different

geometry (e.g. a misaligned geometry). Furthermore, any given file avail-
able in the Persint-00-02-••/AmdcData/share directory (see Appendix D.2,
figure 110a) can be loaded from within the Volumes tab of the Data manager
window.

Figure 5: Warning issued by Persint when the event file expects a geometry file different
from the current file.

Click on the Next event icon of the Event tool bar: the muon chambers which
are hit by reconstructed tracks are displayed.

Next event

1Labels are treated in section 9.1.2.
2See section 6.5.
3See section 10.2.
4The selected detector volumes can be identified by looking at the AMDB and AGDD panes in the

Selector window.
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5. Display the event. 1

Click on the Simulation tracks icon of the Event tool bar: the muon tracks from
the simulation are displayed. The tracks can be erased by clicking again on
that icon.

Simulation
tracks

Click on the Athena reconstruction icon of the Event tool bar: only reconstructed
tracks are displayed along with the associated segments in the chambers. The
segments and tracks can be erased by clicking again on that icon. Athena

reconstruction

Click on the Hit calorimeter cells icon of the Event tool bar: the calorimeter hits
of the event are displayed. The hits can be erased by clicking again on that
icon. Hit calori-

meter cells

6. Make track and cluster selection.

Click on the Set track parameters icon of the Event toll bar. In the pop-up window

Set track
parameters

(Fig. 6) one can choose physics objects, and define some of their parameters. The
usage of this facility is straightforward: items can be selected and momentum (pT )
or energy (E or ET ) thresholds can be set. It is possible to choose the color, the
track shape (ribbon or cylinder), the track width, display the scattering centers
used by the reconstruction program, and define cuts on the impact parameters
(d0, z0) of tracks.
A detailed description of the Set track parameters window is given in Appendix E.5.1,
where all the parameters are shown, in each of the five tabs.

Figure 6: Set track parameters window. The parameters shown here - for the
Reconstruction tab - are those of the predefined parameters of file Zmumu4023.p2ts
mentioned below. See Appendix E.5.1 for the content of all 5 tabs.

1The result of the actions described below depend on the status of the Set track parameters window
(see item 6).
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For this exercise, we will use a pre-defined set of parameters by loading a file
prepared beforehand, which is relevant to the event under study: in the pop-up
window, click on the

�� ��Open box, and in the Persint-00-02-••/example directory

choose the file Zmumu4023.p2ts. Close the window by clicking on
�� ��OK . To

complete the loading of this “track parameter” file (Zmumu4023.p2ts), click on
the Compute icon 1 of the File tool bar. The parameters from this file are then
displayed in the Set track parameters window (Fig. 6). The resulting view is shown
in figure 7. Compute

Figure 7: Resulting display of the exercise in section 6.3

6.4 Save, Export, and Print views

1. Save.
By clicking on the Save view as icon in the File tool bar the view displayed in

Save view as. . .
the main display can be saved as a .p2vf file to the directory of your choice, e.g.
Persint working files. This file (e.g. exercise1.p2vf) can be retrieved for later
use in Persint via the Open view icon.

Open view. . .

2. Export.
By clicking on the Export. . . icon in the File tool bar the view displayed in the main

Export. . .
display can be exported to the directory of your choice, e.g. persint export files.
There is a choice among several formats: .png, .jpg, .bmp for matrix graphics
or .svg, .ps, .pdf for vector graphics. These files can be used in publications

1The Compute icon is one of the most used functions. Whenever in doubt about the status of a
display, clicking on this icon will compute the most recent requests for viewing.
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and presentations 1.
Note that the background color of the display can be chosen with the Background
color function of the Image menu. The grey background in figure 17d illustrates
this feature.
The edges of volumes can be highlighted with the Specific edge color function of
the same menu. Figure 8 shows a display without (a) and with (b) the Specific
edge color being enabled (with the ”red color”).
The effect of the Anti-aliasing function is shown in figure 9. Specific edge color

& Anti-aliasing

(a) Without specific edge color; with Persint logo (b) With specific edge color (red); without Persint
logo

Figure 8: The Specific edge color function and Persint logo of the Image menu.

(a) Without Anti-aliasing (b) With Anti-aliasing

Figure 9: The Anti-aliasing function of the Image menu.
Because the printer performs its own optimization, the effect of Anti-aliasing shown here is less apparent

than on a computer screen.

3. Print.
It is straightforward to use the Print icon in the File tool bar for printing the view

Print
of the main display.

4. Save special. . .
This function allows for comparison between two geometries. In particular, it

makes it possible to use a geometry from a file amdb simrec different from the file
expected from an event file. Invoking the Save special. . . function produces the
following action:

1The inserted Captions, Labels, and Pictures are saved with the display.
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• The current view is saved as a .p2vf macro file named compare persint views.p2vf
into the $HOME/.persint directory.

• The current view is also saved as a .png image file named persint-view-000.png
into the same directory.

If a compare persint views.p2vf file already exists because of a previous use of
the Save special. . . function, a warning is issued which asks you if the existing file
should be loaded.

• If the answer is
�� ��No , the compare persint views.p2vf file is overwritten

and the active display remains unchanged.

• If the answer is
�� ��Yes , the existing compare persint views.p2vf file is

loaded and displayed, and stays unchanged in the $HOME/.persint directory.

In both cases, the view is saved as an image in the same directory with the name
persint-view-001.png 1.

Figure 10: Warning issued when using the Save special. . . function

The use of the Save special. . . function is illustrated in section 9.3.

6.5 Dressing the display with captions, logos, and pictures

The Export function in the Image menu is used to make displays available for presenta-
tions and publications. It is possible to insert captions, logos, and figures in the displays,
as described below.

1. The Persint logo.
The Persint logo can be shown/hidden by checking/un-checking the function Logo
in the Image menu. The result can be seen in figure 8a (with the Persint logo) and
figure 8b (without the Persint logo), and also in figure 27a.

2. Add Caption.
A caption can be inserted in the following way: position the cursor at a cho-
sen location in the display window and right-click. In the pop-up list choose
Add caption and edit the lines of text as for example in figure 11.

Caption/picture
The text format can be chosen, line by line, with the options provided:

Insert special character: the special character palette appears when clicking
on the Ω box; characters are inserted in the text bar at the bottom with a

”double-click”; when the text is composed, click on
�� ��OK to make it appear

in the caption. Special characters include the greek alphabet, arrows, etc.
1The view number is incremented for each subsequent use of the Save special. . . function. If needed,

the files can be deleted from the directory.
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Other available functions (icons, from left to right):
Load caption from. . . ; Save caption as. . . ;
Add event information (Run#, Event#, Time stamp)
Clear the entire text of the caption

Add caption icons

Font: By clicking on the Font box, the font and font size can be chosen.

Vertical alignment: text can be normal, superscript or subscript.

Foreground: The Foreground box lets you choose the color of the font.

Background: Checking the Background box provides the background color of
selected text in the caption.

Figure 11: Add caption window

When opening a new Add Caption window, the previously entered text is displayed,
ready for modifications. The following actions can be taken:

• Remove caption:

Use the Clear captions function of the Clear icon; Clear captions

Actions on captions

or Right-click on the caption and choose Remove caption from the list.

• Export
Captions are saved when using the function Export view as a picture.

• Save view as a .p2vf file: the captions are saved with this function, and can
be retrieved with the .p2vf file.

• Edit caption
Captions can be edited by Right-clicking on the caption and choosing Edit
caption from the menu.

The location of captions cannot be changed; if their location is not adequate, they
need to be removed and redone.

3. Add picture.
Various logos or ad-hoc pictures can be inserted in a Persint display:
position the cursor at a chosen location in the display window and right-click.
In the pop-up list choose Add picture and choose from the proposed list (Fig. 12).

Caption/picture
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Figure 12: Add picture window

(a) Default (b) Black (c) Transparent (d) No text

Figure 13: The four flavors of the ATLAS logos.

The ATLAS logo exists in four flavors: default, black, transparent, and
without text. They are shown in figure 13. It is also possible to load any picture
from an existing file with From file . . . .
Finally, the size of the inserted picture can be adjusted with the Dimensions pa-
rameters in two ways: keeping the original aspect ratio

�� ��<=> or with independent

x,y dimensions
�� ��>=< .

Note two features of the Add Caption and Add picture functions:
• The location of pictures (logos) cannot be changed; if their location is not

adequate, they need to be removed and redone.
• The Clear captions or Clear pictures functions of the Clear menu offer two

options: erase all the captions or pictures or erase only the last. Another way
of removing one particular caption or picture, is to use the Remove caption
or Remove picture in the menu which appears when right-clicking on the
item to be removed.

Clear captions

Remove picture

Figure 14: summarizes the various
possibilities for inserting captions,
logos and pictures in the display
constructed in section 6.3 for figure 7.
The caption reproduces the text
composed in figure 11.
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7 Exercise 2: Muon tracks in your own layout

In this exercise, we will create a custom made event from scratch. By following the
instructions, you should obtain the displays shown in figures 17d and 18b with possible
minor differences due to your choice of colors or navigation.
We want to start with an empty main display window: Start Persint and do not load
the saved file, by answering

�� ��No to the question in the pop-up window (page 15). If you
answered

�� ��Yes , use the Clear icon in the Image tool bar to clear the view in the main
display.

7.1 Generate muon tracks at the IP

In the Event tool bar, click on the Generate muon tracks icon. In the pop-up window
Generate
muon tracks

(Fig. 15), click on the
�� ��+ Add muon box four times. Fill in the parameters of the

generated four muons, for example:
1. η = 0.30; ϕ = 90◦; Pt = 1 000 GeV ;Xv = Y v = Zv = 0

2. η = 0.30; ϕ = 90◦; Pt = 100 GeV ;Xv = Y v = Zv = 0

3. η = 0.30; ϕ = 90◦; Pt = 4 GeV ;Xv = Y v = Zv = 0

4. η = 0.30; ϕ = 90◦; Pt = −4 GeV ;Xv = Y v = Zv = 0

This is done by double-clicking on the value to be edited and using the spinbox which
opens. Values can also be entered via the keyboard.
The muon momentum can be set either with Pt or P . The − > box is used in the
following way:

• Pt − > P means that only Pt can be edited, P being calculated accordingly. Furthermore
if one changes the value of η, Pt is kept fixed and P is recalculated.

• Pt < − P means that only P can be edited, Pt being calculated accordingly. Furthermore
if one changes the value of η, P is kept fixed and Pt is recalculated.

The electric charge of a generated muon is determined by the sign of the Pt or P
momentum: e.g. track # 4 has negative charge.
Click on OK . The four tracks originating from the interaction point (IP) are displayed:
whereas the 100 GeV and 1 000 Gev tracks appear as straight and superposed, the two
4 GeV tracks show clear opposite curvatures in the magnetic field.
Let’s delete the 1 000 GeV track by selection the appropriate line number and clicking
on the

�� ��− Remove muon box. The pop-up window now looks like figure 15. You may
want to choose specific colors for the tracks.
For future use, save the generated muon parameters as a .p2gm file by clicking on
the

�� ��Save box inside the Generate muon tracks window. You may want to use your
persint working files directory as a destination.

Figure 15: Pop-up window for muon track generation
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7.2 Display the detector using the AMDB interface

The Selector window (Figs. 2, 17, and 18) gives access to the AMDB interface to select the
detector volumes to be displayed by clicking on the relevant pictogram. 1 The layout of
this window is determined by the two approximate symmetries of the muon spectrometer:

• The 8-fold symmetry with respect to ϕ of the toroids and the muon chambers in
terms of Large and Small sectors. Thus the octant wheel selector.

• The symmetry between Z ≥ 0 and Z ≤ 0 regions. Thus the Z-halves selector.

Clicking in the center of a “wheel” selects all sectors of a given detector. Clicking again
in the center erases that selection. Sectors can be selected individually by clicking in
the corresponding box, but only adjacent sectors can be displayed in this way. Figure 16
shows the functioning of the selector.

Figure 16: Illustration of the working of the Octant and Z-half selectors

7.2.1 Draw MDT muon chambers

In the Selector window, click on the MDT triangle and then in the center of each of the
BIL, BML and BOL “wheels”. Click on the Compute icon in the Image tool bar to display

Computethe view.
To simplify the view, choose the BIL, BML and BOL chambers of the upper (Phi=90◦)
sector:

Click on the center of each wheel (followed by a click on Compute) to erase the view

Click in the corresponding sector of each “wheel”, as shown in figure 17a

Click again on the Compute icon to display the modified view

The box at the left of the wheel allows you to choose your preferred color, if the default
color is not suitable. You may want to try a “pastel” color and click again on the
Compute icon to display the modified view.
The Wire” box lets you choose between the full or wire modes. (sections 7.7.3 and 9.6).

7.2.2 Draw RPC muon chambers

Click on the RPC triangle and choose the BML and BOL chambers of the upper (Phi=90◦)
sector by clicking on the corresponding sector of each “wheel”, as shown in figure 17b.
Click on the Compute icon to display the modified view. Again, you may want to choose
a color.

1The AGDD interface is described in section 7.5.
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7.2.3 Draw Inner Detector

In the Selector window, click on the ID triangle. Click in the left-most third of the
horizontal box, as shown in figure 17c, to select all sectors located at Z < 0 (1). Here we
have kept the default color. The view which has been composed appears in the Main
Display window and resembles figure 17d. Note that it is possible to click the Compute
icon only once, after having made all selections in succession.

(a) Selection of MDT chambers (b) Selection of RPC chambers

(c) Selection of the Inner detector (ID) (d) Resulting display. Note the background color (see sec-
tion 6.5, item 2

Figure 17: Illustration of the operations (a,b,c) resulting in the display shown in (d).
The selections are highlighted inside a red ellipse.

7.2.4 Optimizing the view: a first try at navigation

It is appropriate, at this time, to have a preview of the Navigation tool (Fig. 2) in order
to place the view at the center of the display, with the proper magnification. To do
this, we use the Navigation tool bar, in particular the Default mode which is the ‘magic
wand” used most often.

Click on the Default mode icon of the Navigation tool bar.
Default mode

1To check if this horizontal box corresponds indeed to Z < 0, display the axes of the ATLAS coordinate
system by clicking on the Axes icon of the Image tool bar and choose e.g. Huge axes in the menu. When
done, erase the axes by choosing No axes. The coordinate axes are shown in figures 21, 59b, 60, and 61a.
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1. Drag the view to the middle of the display with the right button of the
mouse pushed down. The displacements can be in any direction in the
display.

2. Rotate the central wheel of the mouse to zoom-in or zoom-out, so that
the view occupies the whole display.

3. The left button of the mouse is used to rotate the view in 3-dimentional
space.

The detailed description of the Navigation tool bar is in section 8 and Appendix E.3.

7.2.5 Starting anew

In case the result of an operation (navigation, addition of volumes, etc.) is not satisfac-
tory, the Previous view icon allows you to retrieve the view which was displayed before

Previous view
the latest Compute step. Up to ∼ 100 previous steps can be retrieved.

7.3 Place the calorimeters

In the Selector window, click on the CAL triangle and click successively on items in the
ECAL and HCAL lines. Make the selections shown in figure 18a: select the left-most rect-
angle to display the Z < 0 part of the calorimeters and choose the colors. The resulting
display is shown in figure 18b.

(a) Selection of ECAL and HCAL (b) Resulting display

Figure 18: Additional selections (a) resulting in the display shown in (b).

Comparing figure 17d and figure 18b, one notices that when the material of the calorime-
ters is included (Fig. 18b), the two low momentum tracks, generated with 4 GeV at the
IP, are bent more by the magnetic field, because of the energy loss in the calorimeters
(' 3 GeV on average) is now taken into account. 1

7.4 Save files for future use

Let us suppose you must now interrupt your work.
In order to be able to retrieve, at any time, the view displayed in figure 18b, save it

1The energy loss is taken into account as soon as one element of the calorimeter is chosen in the
Selector window even if the track does not cross the element which is displayed, as in figure 18b.
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as a .p2vf file to a directory of your choice (e.g. persint-working-files, as suggested in
section 6.1). This is done with the Save view as icon of the File tool bar.

Save view as. . .The saved view, e.g. exercise2.p2vf, only contains the detector volumes. It is neces-
sary to also save the generated muons as a .p2gm file from within the pop-up menu of
figure 15. If not already done, open the Muon generation pop-up window and save the
parameters by clicking on the

�� ��Save box. You may again choose the persint-working-
files directory to store the saved exercise2.p2gm file.

You may also want to export the view in order to use it for a presentation: use the Export

Export. . .

icon of the File tool bar to save it, e.g., as my-presentation.png to the persint-export-files
directory.

7.5 Place inert material using the AGDD interface

With the AGDD pane in the Selector window, one selects the inert material to be
displayed 1. In figure 19, we have displayed one of the two endcap toroids, the rail
assembly, and the saddle for the barrel calorimeters.
Selections in the AGDD pane can be made at several levels of detail, according to the
tree structure which is provided.

Figure 19: Selections made in the AGDD pane to obtain the modified display.

7.6 The Dead material function

The Dead material function is used for taking into account dead material traversed by
tracks, even when the material is not selected for display.

1Calorimeters (ECAL, HCAL) and the inner detector (ID) are accessed with the AMDB pane.
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7.6.1 Preparing the working view

If you resume work with a new session of Persint, you want to display the view of
figure 18b. When starting Persint anew, the view which was in use in the previous ses-
sion is reloaded, provided you answer

�� ��Yes in the initial pop-up window (Figure on
page 15). This is because the current view is automatically saved when quitting Persint.
In any case, the view may be retrieved since it was saved as exercise2.p2vf in sec-
tion 7.4 by clicking on the Open view icon. Using the window which opens, choose the
file exercise2.p2vf in the persint-working-files directory and click on

�� ��Open .

Open view. . .You must also load the file containing the generated muon tracks which was saved as
exercise2.p2gm.

Click on the Generate muon tracks icon and, in the Muon generation window,
click on the

�� ��open box to retrieve the exercise2.p2gm file saved in your
persint-export-files directory. 1

If necessary, click on the Compute icon. Figure 18b should now be displayed.

Generate
muon tracks

Compute7.6.2 Use of the Dead material function

We now have figure 18b as working display, with the detectors and the 3 generated muon
tracks. Note the visible curvature of the 4 GeV tracks, as they loose energy in crossing
the calorimeters.
We will now remove the calorimeters from the display: in the AMDB pane of the Selector
window, in the CAL arborescence deselect ECAL and HCAL by clicking in the center of
the two wheels (see Fig. 18a). When hitting the Compute icon of the Image menu, the
tracks now appear less curved, i.e. without the energy loss.
The energy loss can however be restored by clicking on the Use all dead matter icon of the
Events menu. With this icon one can switch to displaying the muons with or without
energy loss, even though the calorimeters are not shown in the display. This feature
comes in handy for showing realistic muon tracks when material must be ommitted for
clarity of the view. Use all dead matter

(a) Muon tracks without energy loss in dead matter (b) Muon tracks with energy loss in dead matter

Figure 20: Display of figure 18b, but where the calorimeters are not selected for display.
Use displayed dead matter only has been selected in a), Use all dead matter in b).

1If this file was not saved, it is easy to generate the muon tracks again, as indicated in section 7.1.
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7.7 Look at the event in detail

In this section, we will continue work with figure 18b. If needed, restore that view as
shown in section 7.6.1. We will look at the ATLAS coordinate system, produce a pro-
jected view, and finally zoom-in to look at the MDT tubes in detail.

7.7.1 Show ATLAS coordinate system

The ATLAS coordinate system is shown in Appendix C (Fig. 109).

1. Click on the arrow of the Axes icon and choose Huge axes.

Axes

2. Click on the arrow of the Projection icon and choose Invert.
The view is inverted with respect to the Z axis.
Go back to the original orientation by repeating the Invert operation.

3. Erase the axes by clicking on the Axes icon again and choose No axes.

7.7.2 View the event in the X-projection

Click on the arrow in the Projection icon and choose X.
A projection perpendicular to the X-axis is displayed, in the (Y, Z) plane (Fig. 21).

Projection

Figure 21: Resulting X-view from manipulations in section 7.7.2. The energy labels have
been added by hand. See section 9.1.2 for labels generated by Persint.
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7.7.3 Zoom-in on muon chambers

1. Select the Default mode in the Navigation tool bar and, with the “wheel” (“central
Default modebutton”) of the mouse pushed down, select a region in the BML chamber including

the two tracks as shown by the red rectangle in figure 21.

2. In the Selector window, choose the ‘‘MDT options’’ tab and check the boxes as
shown in figure 22a.
Choose the ‘‘RPC options’’ tab and check the boxes as shown in figure 22b.

3. Click on the Compute icon.

4. Note that the selections can be made to produce displays in the solid or wire
modes.

means: item displayed in solid mode

means: item displayed in wire mode

means: item not displayed

(a) Selected MDT options (b) Selected RPC options

Figure 22: Selections made in the Option tabs in the Selector window

A view similar to figure 23 should be displayed. It shows the three generated muon tracks
crossing the two layers of MDT tubes and RPC Z-strips, in the BML station 1 . The
two colors of the tubes alternate every 8 tubes (for easier tube identification) and can
be chosen in the ‘‘MDT options’’ of the Selector window (Fig. 22a.). The red squares
represent the centers of multiple scattering used by the program.

The display in figure 23 can
again be saved as a .p2vf
file into one of your work-
ing directories (use the Save
view icon). It can be re-
trieved with the Open view
icon. The same is true
for the generated tracks:
they can be saved as a
.p2gm file and retrieved by
opening this file inside the
Muon generation window
opened with the Generate
muon tracks icon (see sec-
tion 7.6.1).

Figure 23: Resulting X-view from manipulations in
section 7.7.3.

1A detector station is the mechanical entity holding several layers of detector planes. For example, a
BML MDT station is made of two triplets of drift tubes (see fig. 23).
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8 Exercise 3: Practicing Navigation

The interface to the various graphics applications of Persint is provided by the Navigation tool bar
on the right hand side of the display (Fig. 2 and Appendix E.3). Its functions allow spa-
tial navigation and modifications of the visualization properties.
The desired perspective is obtained by changing the viewing point and the viewed point,
by changing the focal length of the observer eye. The view may be rotated, displaced,
enlarged or made smaller (Zoom). For Zoom in/out and Rotation, the amplitude of
movements can be chosen with the Navigation scale gauge.

Navigation scale

Figure 24: The scale can be changed by moving the cursor or
by opening the spinbox with a click on the three dots �� ��... , and
setting the scale with the keyboard. The default value of 1.0000
is displayed.

8.1 Preparing the working view

In this section, we will learn to use the spatial navigation tools and start with the view
which was saved as exercise2.p2vf in the previous exercise (section 7.4, Fig. 18b).

Start the Persint application and click on the Open view icon of the File tool bar. Load

Open view. . .

the exercise2.p2vf file, from the persint working files directory. The view of figure 18b
is now displayed.

(a) Barrel MDTchambers (b) Endcap MDTchambers (c) Selection of toroid coils and feet

Figure 25: Additional choices made in the Selector window to display the muon spec-
trometer

From the Selector window, add a second adjacent large sector and one adjacent sector of
small MDT chambers (fig. 25a) and a few endcap MDT chambers (Fig. 25b). Check the
result by clicking on the Compute icon. Three barrel toroid coils 1, one of the endcap
toroids, as well as the detector feet are added when the selection shown in figure 25c are
made2. When clicking on the Compute icon, the view of figure 26 is displayed.

1The toroids can be displayed in much more detail using the AGDD pane of the Selector window.
2Note the selections of HCAL, ECAL, and ID associated with the selections already made in exercise 2.



38 8 EXERCISE 3: PRACTICING NAVIGATION

Before starting with the navigation, save the view for future use: click on the Save view as
icon and save the view as Exercise3.p2vf into the Persint working files directory.

Figure 26: Detector layout resulting from the additional selections made in Exer-
cise 3. The information box is obtained by positioning the cursor on the chosen volume
EOLF4Z+6 (see section 9.1.1).

8.2 The Default mode: a magic wand

The Default mode is the most powerful function of the Navigation tool bar. With this
icon selected, all three buttons of the mouse can be used to perform the most frequent

Default modenavigation actions, as we have already seen in section 7.2.4.

1. The left button of the mouse is used to rotate the view in 3-dimentional space.
Keep the left button pushed down and move the cursor anywhere inside the display.
Start with simple movements, e.g. horizontal, vertical, and then use more complex
movements. The actions and results are very much intuitive.

2. Rotate the central wheel of the mouse to zoom-in or zoom-out. Practice by
making successive reverse zooms to the view.

3. With the right button of the mouse pushed down, the view can be translated in
any direction inside the display.

4. By pushing the central wheel down (without rotating it), one selects a rectangular
zone to be zoomed, as already exercised in section 7.7.3 (Fig. 21). This action is
called Zoom on custom area.

5. By pushing and releasing the right button of the mouse on any detector volume,
a pop-up menu is displayed from which various operations on the volumes can be
performed. These operations include moving volumes, adding labels, captions, or
pictures, and are described in section 9.
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Note that the amplitude of the first two actions (rotation and Zoom in/out) can be tuned
with the Navigation scale. Remember that the scale can also be set with the Spinbox
accessible with a click on the �� ��... of the Navigation scale icon.

Navigation scale

8.3 Single functions

The 5 functions described below can all be performed with the Default mode icon (the
magic wand) and are in fact redundant. However, when repeating the same action many
times, it may be advantageous to use a single function.

1. Translation
Activate the Translation icon and use the left button of the mouse to translate

Translationthe view in any direction.

2. Zoom-in
Activate the Zoom-in icon and click on the left button to zoom-in on the view. Zoom-in

3. Zoom-out
Activate the Zoom-out icon and click on the left button to zoom-out on the view.

Zoom-out
4. Zoom on custom area

Activate this icon and use the left button to select a region (red rectangle). When

Zoom on
custom area

the button is released, the zoom of the selected rectangle is performed.

5. Rotation
Activate this icon and use the left button to rotate the view around the center

Rotation
point of the display, with the appropriate movements of the cursor.

8.4 More functions

The remaining functions of the Navigation tool bar are:

1. Initial Zoom
Activate the Initial zoom icon with the left button to retrieve the original zoom

Initial zoom
parameters. Note that if this function is used on a projected view (e.g. X-view),
the Initial zoom action brings back the 3-D view.

2. Set center
Selecting the Set center icon and then clicking on a given volume centers the view

Set center
on that volume 1. The point around which a view is rotated is chosen in this way.

3. Navigation scale
As already mentioned, with this function it possible to change the amplitude of
two navigation actions: Rotation and Zoom in/out.

4. Focal length
The nominal focal length is 35 mm. It can be changed with the cursor of the
Focal length icon, and set back to the nominal value with the Reset focal length

Focal length and
Reset iconsicon.

5. Isometric view
By clicking on this icon, one produces an isometric view (infinite focal length). To
return to the previous focal length, click on the icon again.

Isometric view

Some results of using these functions are shown in figure 27, where the same volumes are
shown with different perspectives.

1This action is more efficient (faster) than using the Translation function.
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(a) Focal Length=35 mm (b) Focal Length=70 mm

(c) Isometric view (FL=infinite) (d) Rotated view

(e) Z projection (f) X projection

Figure 27: Defining the viewing perspective

The two remaining functions will be explained in the next exercise (Section 9).

1. Volume information

2. Selection mode
Volume information Selection mode
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9 Exercise 4: Exploring more features

We start with the view saved at the end of exercise 3. Click on the Open view icon and

Open view. . .

open the file Exercise3.p2vf from your Persint working files directory. This should
display the view of figure 26.

9.1 Volume information labels

9.1.1 Volume identification with information boxes

You will have noticed that by positioning the cursor on a volume, an information box is
shown which displays the identity of the volume and its geometrical parameters. It is a
convenient feature to identify any volume in the layout.

9.1.2 Label maker

When saving displays to be used for publications or presentations, it is useful to be
able to also display the volume parameters (volume identification, position, . . . ) and
an explanatory text. This is achieved with a feature which makes labels, as explained
below. 1

1. Default labels
By right-clicking on a volume (in this case a MDT chamber) 2 and releasing the
button, one produces the pop- up window of figure 28a. Choose

�� ��Add/Remove label

/
�� ��Add default label to obtain the default label which displays the “Hardware

name” of the chosen muon chamber (BOL5C05) 3, as shown in figure 28b. If the
geometry file does not provide the ”Hardware name” the ”Software name” is dis-
played.

(a) Pop-up window when right-clicking on a
volume in the Display window.

(b) Default label for a MDT chamber

Figure 28: Making a Default label

To remove the default label, repeat the operation by right-clicking on the same
volume and choose

�� ��Remove label . The Clear labels function clears all labels Clear labels

present in the display. The Reload event function has the same effect.

Reload event2. Customized labels
The label can be customized by clicking

�� ��Add customised label (figure 28a). In
the window which opens (Fig. 29), the complete Volume information appears and
room for Additional text is provided.

1Labels are saved when using the Export View. . . and Save view as .p2vf file. . . functions.
2Tracks labels are obtained with the same procedure, by clicking on the tracks (Fig 56 in section 10.4).
3BOL: Barrel Outer Large chamber; 5: 5th chamber from | Z |= 0; C side (Z < 0) [A side (Z > 0];

05: sector number. See reference [7] for conventions on chamber numbering.
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The Customized label has 5 lines of information:

(a) Hardware name of the chamber (EOL6A07)
(b) Software name of the chamber.
(c) X,Y,Z coordinates of the cursor.
(d) R, ϕ, η coordinates of the cursor.
(e) Magnetic field (Bx, By, Bz)

Figure 29: Pop-up window when choosing Customised label in the window of figure 28a.

It is possible to place the label at four different positions with respect to the
cursor position (SE, SW, NW, NE). Click on

�� ��OK , after having chosen “NE”; the
customized label of figure 30 appears in the NE position.

Figure 30: Custom label for an endcap MDT chamber

To remove the customized label, repeat the operation by right-clicking on the
same volume and choosing

�� ��Remove label . With the Clear labels function it is
possible to remove the latest label or all labels. clears all labels present in the Clear labels

display. The Reload event function has the same effect, if indeed an event is
displayed.

Reload event
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9.2 Hide/Displace volumes or super-volumes

There are several ways to remove a volume or super-volume from the display. Technically
this is done by setting the coordinates of a volume to very high values, thus the term
“Move to infinity” used in the relevant functions.

(a) Partial display of the initial layout of endcap
chambers

(b) Partial display after the hiding of 3 volumes
and 2 super volumes

Figure 31: Hiding volumes and super volumes

9.2.1 Hide volumes

The simplest way to hide a volume is to right-click on a volume, release the button
and choose

�� ��Move volume to infinity or
�� ��Move super volume to infinity in the pop-up

window (Fig. 28a). In the following example, we proceed to hide MDT endcap cham-
bers: 3 volumes and 2 super modules in two neighboring sector. The procedure is simply
repeated for each chosen volume (5 operations). Figure 31 shows a partial display of the
initial layout and the result of the hiding. 1

In order to restore the initial layout, simply click on Displaced volumes. In the pop-up

Displaced volumes

window (Fig. 32), choose
�� ��Reset all the displacements and click on

�� ��Close window : the
initial view is restored.

It is also possible to individually select the volumes to be returned to the display by select-
ing each volume in the pop-up window (Fig. 32) and clicking on

�� ��Reset volume displacement .

The action takes place when the
�� ��Close window box it clicked on.

Figure 32: Pop-up window showing displaced volumes

1The labels in figure 31a are produced as explained in section 9.1.2
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9.2.2 Hiding volumes, the fast way with Selection mode

Selection mode

If a number of volumes or super volumes must be hidden, there is a fast and efficient
way to do so with the Selection mode of the Navigation tool bar.

Figure 33: Selected volumes window

Click on the Selection mode icon of the Naviga-
tion tool bar and click on the volumes or super
volumes to be displaced. The list of selected
items appears in the Selected volumes pop-up
window, shown in figure 33.

A left-click selects a volume (in blue).
A right-click selects a super volume (in red).

Use the
�� ��Move to infinity button to hide the

(super) volumes listed in the window. Note
that volumes to be hidden can also be selected
using the functions available in the window
shown in figure 28a. This window is obtained by
right-clicking on a volume, the Default mode
being selected in the Navigation tool bar. In this
case, the list of volumes to be hidden is made by
choosing Select volume or Select super volume.

The color of all selected volumes and super volumes can be changed by using the func-
tion which is provided through the

�� ��Edit color button.
The third button,

�� ��Un-select all , can be used to clear the entire list.

9.2.3 Displacements of volumes

It is possible to change the display parameters of volumes by selecting the Volume in-
formation icon in the Navigation tool bar and clicking on the volume to be altered. Volume

information

Figure 34: Modify volume window

This opens the Modify volume window shown in
figure 34.

The functions used most often are:

1. Selecting a volume or super volume by
clicking on the appropriate button.

2. Changing the color of the volume/super
volume.

3. Hiding volume/super volume (i.e. “Move
to infinity”), a function already performed
by other means (section 9.2.1).

Click on
�� ��OK to view the changes made to the

selected volume.
The two other features (Translation and Rota-
tion) were used extensively during the design
of the muon spectrometer and during the com-
missioning phase with cosmic rays. The devel-
opment of the reconstruction software also ben-
efited from this tool.
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9.3 Compare geometries

The comparison of displays obtained with different geometries can be performed with the
Save special. . . function described in section 6.4. Below are two figures which illustrate
its use. They were obtained with two different geometries of the supporting structure of
ATLAS (the ”feet”). The following exercise is done with a pre-loaded .p2vf file located
in the directory Persint-00-02-••/example. It can be repeated with any other .p2vf file
of your choice.

1. First, using the Open view function, we display the feet structure by loading the
relevant file compare persint views.p2vf, located in the directory Persint-00-
02-••/example . The expected geometry is amdb simrec.r.04.01 and should be

Open view. . .loaded by choosing
�� ��Yes in the warning box. This geometry file is located in the

Persint-00-02-••/AmdcData/share directory.
When the ATLAS ”feet” are displayed, we perform a zoom to get figure 35a. By
using the Save special. . . function of the File menu, the .p2vf file is saved into
the $HOME/.persint directory and an image file persint-view-000.png is written
into the same directory.

2. We now change the geometry description. Click on the Data manager icon of the
File menu and choose the Volumes tab. Click on

�� ��Load and choose the new geom-

etry file amdb simrec.r.03.01.Initial.Light.EIL.BML.S13.Patch. 1 Close the
Data manager window. We now want to load the compare persint views.p2vf
file again to display it with the new geometry. Proceed as above, using the Open
view function. Answer

�� ��No in the warning box in order to use the new geometry,
and not the geometry expected by the .p2vf file. Ignore the AGDD warning. Per-
form a zoom to obtain figure 35b. Use the Save special. . . function again, and the
new display is saved as persint-view-001.png into the $HOME/.persint directory.

3. These two .png images are now available for comparisons. Toggling between the
two images, persint-view-000.png and persint-view-001.png shows the differences:
there is less material in the first.

(a) First feet geometry (b) Second feet geometry

Figure 35: Two ”feet geometries” to be compared.

1Geometry files of the amdc simrec type are available in the Persint-00-02-••/AmdcData/share
directory.
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9.4 Detect volume clashes

This feature was used extensively during the building of the geometry files (GeoModel).
It is not commonly used, except by developers of geometry data bases. For completeness,
its functioning is explained below.
We continue working with the display of figure 31a, which should be the current view.
If not, you can use one of the following three methods to get this view back:

• Use the Previous view function of the Image tool bar once or several times. Previous view

• In the pop-up window of Displaced volumes (Fig. 32) click on
�� ��Reset all the displacements

and then on
�� ��Close window .

• If the view has been saved, as indicated in section 8.1, use the Open view function
to load the saved Exercise3.p2vf file.

We now want to displace a volume to produce a clash between two volumes.
In the active display (Fig. 36a), zoom on the area shown in red by using the Zoom on
custom area of the navigation tool bar. We obtain figure 36b.

Zoom on
custom area

(a) Starting display (same as Fig. 26) (b) Detailed view of end cap MDT chambers after zoom

Figure 36: Displays used for detecting clashes

1. Right-click on the EOL chamber 1(the violet volume) and choose Volume infor-
mation in the pop-up window 2.

Volume
information2. In the Modify volume window, select the Supervolume EOL F4 Z+6 and set the

Ax angle to 6 degrees, as shown in figure 37a. After performing a Zoom, we obtain
figure 37b.

3. To identify the clashes resulting from the rotation, click on the Clashes menu (down
arrow) and check Select all clashes. Clashes

Click on the Clashes triangle to open the Clashes window which lists the 5 pairs

Clashes
of volumes which present a clash (Fig. 38a).
The list of clashes can be saved as a .txt file with

�� ��Save as , or stored for future
comparisons within Persint with the

�� ��Store box. The default name is "Backup no.1".

1Remember that a volume can be identified by positioning the cursor on it, in order to activate the
information box (see section 9.1.1).

2Alternatively, you can select Volume information in the Navigation tool bar, and click on the volume.
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(a) Modify volume window for
rotating chambers

(b) BOL volume displaced by 6◦; the clashes are in red

Figure 37: Rotate EOL chamber by 6◦

4. We now change the rotation of the same EOL chamber to 3◦ (instead of 6◦) by
changing the value in the Modify volume window of figure 37a.

After having closed the window with
�� ��OK , click on the Clashes triangle to display

Clashes

again the clashing volumes: only two clashes are left.
Again, the list of clashes can be saved as a .txt file with the

�� ��Save as box, or
stored for future comparisons within Persint with the

�� ��Store box. This time the
default name is "Backup no.2".

5. Finally, we can compare the two stored geometries. In the Clashes window, click
on the

�� ��Compare clashes box. In the window which appears (Fig. 38b), select the

two stored files "Backup no.2" and "Backup no.1" and click on
�� ��Compare .

Use the tabs on the left hand side to perform the comparisons:
Remaining Clashes Solved Clashes New Clashes

(a) Clashes window when EOL is rotated by 6 degrees. (b) Compare clashes window

Figure 38: Compare clashes for two geometries



48 9 EXERCISE 4: EXPLORING MORE FEATURES

9.5 Animation

It is possible to produce an animation of a displayed view. Parameters such as ampli-
tudes of rotation and zoom, number of iterations can be chosen. The generated frames
can be used as input for video software.
You may use any view made with Persint, but for simplicity, we start with the view of
figure 26. Choose the function Open view of the Image menu. Open the file Exercise3.p2vf
in the directory Persint working files where it was saved in section 8.1.

Open view. . .

Choose Animation in the Tools menu. In the Generating animation window which opens
Animation(figure 39), choose the parameters, e.g. those indicated in the caption below.

Figure 39:
The parameters are:
- Number of steps (iterations)
- The parameters of the motion (Direction
and angle of rotation; Zoom factor)
Options:
- Save images
If the generated frames are to be saved,
check the Save images box (the default
is ”no save”), choose the Directory, the
filename and the format (extension .png,
.bmp or .jpg)
- Stereoscopic mode

Clicking on the
�� ��OK box will start the animation. With the parameters chosen (Fig. 39),

the view rotates in 36 steps of 10 degrees, for a complete revolution.
The Save images box having been checked, 36 files are saved in the specified directory
for future use by video software. With the Stereoscopic mode enabled, the number of
saved frames would be doubled.
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9.6 Wire mode

The wire mode exists in two flavors:

1. Global Wire Mode.
In the Wire mode, the program bypasses the time-consuming computation of hid-
den faces and volume intersections. This results in a much faster processing of the

Wire mode

view for display and optimal fluidity in the displacements.
It can therefore be advantageous to switch to the wire mode when making complex
navigations, and go back to the full volume display when finished.

2. Partial Wire Mode.

By checking the appropri-
ate box in the “Wire” col-
umn in the Selector window,
groups of volumes can be
displayed in the full or in the
wire mode. This function
is used to make certain vol-
umes ”transparent” in order
to get a view ”inside” the
detector. Figure 40: Partial Wire Mode switched on.

The partial wire mode can also be chosen in the ”MDT options” and ”RPC/TGC
options” panes (see Fig. 22).

9.7 Magnetic Field Interface

The Magnetic Filed interface provides a fully interactive 3D visualization of the magnetic
field. This application is coupled to a set of subroutines that read the field database and
compute the field at any given point.

9.7.1 Loading a Magnetic Field file

The muon spectrometer magnetic field map is loaded from the Magnetic field tab of the
Data manager window (Fig. 4b). Several options are available:

-
�� ��Select : opens a different map from the directory Persint-00-02-••/amdcData/share; once the

map name is displayed, it must be loaded by pushing
�� ��Load to become the Current Map 1.

-
�� ��Select Default Map : Define the Current map as the Default map.

�� ��Load needs to be pushed

for the map to become active.

-
�� ��Modify Default Map : make the Current map the Default map.

-
�� ��Load : effectively loads the magnetic field map after it was

�� ��Select ed.

-
�� ��Close : closes the Data manager window.

All field maps contain a generic description of the solenoid field in the inner detec-
tor region. However, one can use more accurate solenoid field maps by checking the
Solenoid Magnetic Field box and loading the desired map, following the same procedure
as above for the toroid map.

1Additional field maps can be loaded from a CERN directory into the ”Persint-00-02-••/BFieldData/share”
directory (see 11.1.4, page 71).
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9.7.2 Display B-field lines

The magnetic field interface is launched in the following way: in the Selector window
open the Magnetic field pane (Fig. 41a) and check the Display magnetic field box.
The field is visualized by means of arrows located at a series of lattice points. The
direction and length of the arrow corresponds to to the direction and magnitude of the
magnetic field. The field display can be customized with the following choices:

- Color of the arrows

- Linear or logarithmic scale

- 3D or projections, at x, y, or z positions

- Lattice for field display

The vector field can be built either in a very localized region or over large distances.
Once all properties of the field visualization are defined, the display is obtained by
clicking on the Compute icon.

Compute

Finally, elements of the Magnet system can be visualized through the AGDD pane of the
Selector window. Figure 41 shows an example of a display of the magnetic field where
one element of the cold mass of a barrel coil is shown.

(a) Chosen display parameters (b) Display of field lines

Figure 41: Example of magnetic field lines displayed with a barrel toroid cold mass,
selected with the AGDD interface. The parameters in (a) are used to obtain display (b).
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9.7.3 Display B-field maps

• B-field map
The Magnetic field map can be displayed by clicking on the first (left) button of
the Generate maps box in the Magnetic Filed pane of the
Selector window (Fig. 41a) 1. The Select options for map window opens and the
parameters can be chosen in the three available panes (Fig. 42):
− Field Component (Br, Bφ, Bx, By, Bz, Btot)
− The Variables to be displayed in 2D plots (Xvs.Y,Xvs.Z, Y vs.Z) and the value
(position) of the 3rd coordinate; or 1D plots (R,φ, Z,X, Y );
− In the Lattice pane one can select the range of the axes and the step (Fig. 42c).

When all the parameters are set, click on one of the OK buttons.
Figure 43 shows the 2D field map.
Several other field maps may be added to the display by using

�� ��Add map . Each
map can be saved with a choice of formats (.png, .eps, .pdf, etc.)

The magnetic field file used (bmagatlas05 test2) is one of the files available 2 in
the Magnetic field pane of the Data manager window (see 6.1.1, and figure 4b).

(a) Field component (b) Variable(s) to be displayed (c) Lattice

Figure 42: Selecting options and variables for displaying the 2D field map.

Figure 43:
2D display of Btot in the X − Y plane at Z = 500cm.

The corresponding selections are shown in figure 42.

Units are Tesla and m.

1An alternative is to use the Tools menu: Tools/Histograms. . . /Map of magnetic field (see
Appendix E.6).

2Additional field maps can be made available through the Download. . . button in the Data manager
window (see 6.1.1, item 2, page 19); or by choosing Download. . . in the File menu (Appendix E.1).
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The magnetic field can also be illustrated as 1D plots. With the selections shown
in figure 44, the total field Btot is shown as a function of R in figure 45 (Map 1).

(a) Component (b) Variables (c) Lattice

Figure 44: Selections for 1D plot of the magnetic field.

The field of the central solenoid magnet can be added, as shown in figure 45
(Map 2), with the following selections (made in the panes of figure 44):

Component= Bz; Variable= Z, at ϕ = R = 0 ; Lattice: Z ∈ [−300, 300]cm.

Figure 45: Units are Tesla and m.

Map 1: 1D display of Btot as a

function of R at Z = 5 m, ϕ = 0.

Map 2: display of Bz as a function of

Z at R = 0, ϕ = 0.

With the MDI 1 button, the display can be arranged to show each map separately,
using the tabs, as shown in figure 46.

Figure 46: Same as figure 45, but in

MDI mode, showing one plot at a time

in separate tabs.

1Multiple Document Interface
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• Integral B-field map (
∫
Bdl)

The integral field can be displayed by clicking on the second (right) button of the
Generate maps box in the Magnetic Filed pane, after having chosen the lattice in
the pop-up window (Fig. 47a) 1. The field integral is shown in Fig. 47b.
A 1D plot of

∫
Bdl is shown in figure 48.

(a) Choose the lattice (b) Resulting map of
R
Bdl

Figure 47: Map of the field integral
∫
Bdl. The unit is Tesla.m

(a) Selection for 1D plot (b) Lattice for 1D plot (c)
R
Bdl as a function of η

Figure 48: 1D display of
∫
Bdl

1OR: Use the Tools menu: Tools/Histograms. . . Map of field line integral.
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9.8 X0 map: Distribution of material

The amount of material (in units of radiation length X0) along any chosen direction
from the interaction point can be displayed in the following way.
In the Option pane of the Selector window (Fig. 2), choose the X0 tab, and hit the
Generate X0 Map button 1.
In the Select options for Map window (Fig. 49a), the lattice (η, ϕ) and the integration
range (R, Z) can be chosen. The resulting map is shown in figure 49b. The regions
with high quantities of material because of the magnet coils are clearly visible (in warm
colors): at ϕ = 22.5◦ for the barrel region and at ϕ = 0◦ and 22.5◦ in the forward region.

(a) Choose the options for the display (b) Resulting map of X0

Figure 49: Map of X0.
a) The window Select options for Map allows to choose the direction (η, ϕ) along which the
amount of material - expressed in units of X0 - is calculated , as well as the integration range
(R, Z).
b) Two dimentional (η, ϕ) Map of X0. At the right, the color scale for the amount of material is
expressed in units of radiation lengths (X0).

1OR: Use the Tools menu: Tools/Histograms. . . Map of X0.
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9.9 Map of the expected number of crossed muon stations

Ideally, the number of detector stations crossed by a muon is at least 3. There are
regions in the spectrometer where this is not the case: e.g. in the transition region
between barrel and endcap (around | η |' 1.2), where a muon crosses fewer stations;
and also at various regular azimuthal angles. The tool described below makes it possible
to determine the number of stations at any given η and ϕ.
The map is obtained by generating straight tracks from the IP and propagating them
through the spectrometer, counting the number of chambers on the trajectory.

In the Tools menu, choose Histograms. . . / Map of expected stations. In the pop-up
window, make the desired choices for the η and ϕ ranges; select the Type of chambers
(Precision or Trigger) and select Use all chambers, as shown in figure 50a.

Clicking on
�� ��OK , produces the map of figure 50b. The regions where only one station

or none are crossed can be clearly identified (blue resp. purple).
There are also a few rare regions where the number of expected stations exceeds 3, as
indicated by the regions in yellow.

(a) Choose the options for the display (b) Map of Number of expected stations

Figure 50: Number of expected stations.
a) Options for displaying the map: η and ϕ ranges, type of chambers, selection of chambers.
b) Two dimentional (η, ϕ) map of Number of expected stations. At the right, the color scale for
the number of stations.

By using the selection Use displayed stations only in figure 50a, it is possible to restrict
the map to the stations displayed in an event.

In any of the resulting maps (Figs. 43, 45, 46, 47b, 48c, 49b, 50b, ), several actions are
possible with the tabs at the bottom of the display:

• Range : Set the range of the color scale for the plotted quantity .

• Export : Saves the map as an ASCII file (.dat format).

• Save : Saves the map as a picture with a choice of formats (.png, .eps, .pdf, etc.).

• Close window without saving or exporting.
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10 Exercise 5: ATLAS Physics Events (1)

10.1 Input files

10.1.1 Files loaded by the user

Persint allows the reading of event hit files and the visualization of these hits. It is also
possible to reconstruct the event interactively 1. All this is done with the help of the
Events menu (Appendix E.5).

To display event hits, the following files must be loaded:

1. A geometrical data base of the ”amdb simrec.xxx” type.

2. An input Event file containing the hits of the ”OutMboyView yyy” type. The
structure of this ASCII file is given in Appendix D.3.6, and an example Event file
in Appendix D.3.7.

The interactive reconstruction of events requires the loading of two additional files.

1. The Magnetic field file

2. The user’s directives in the form of ”Data cards”

All these files are available through the Data manager icon of the File tool bar. For
details, refer to section 6.1.1, figure 4, and Appendix D, figure 110a. As already men-
tioned, these files are loaded, if available, in the working directory. The program checks
if the correct files are loaded. If there is a discrepency between the loaded geometry file
and the event hit file, 2 a warning is issued and the correct file(s) can be loaded (see
section 6.3, item 4, and figure 5 on page 22).
The user may change these input files at any time during the running of Persint. 3

10.1.2 Event dependent files

The geometry file of the ”amdb simrec.xxx” type which is loaded at the beginning of
a session represent the nominal geometry corresponding to the event file in use. The
actual geometry, which represents the state of the detector at any given moment, must
be used. Using a port 4 to a CERN data base, these files are invoked for each event
displayed with Persint according to its time stamp.

→ The "missing" file indicates the detector parts or channels which are inoperative
for a given event.

→ The "Corr" file provides the alignment parameters (A lines) and deformation pa-
rameters (B lines) of the precision chambers.

10.2 Display physics events (Exercise 5 starts here)

For this exercise, we start from scratch.
After starting Persint, we erase the display window with the Clear button of the Image

Clear1The interactive reconstruction is using the interface with the Muonboy reconstruction program.
2The event hits file ”OutMboyView yyy” indicates the required geometry file in its header

(Appendix D.3.7)). The file ”Persint-00-02-••/PersintData/AtlasNode AmdcFile MagFieldFile.txt”
indicates the magnetic field file needed for a given geometry file (Fig. 110b).

3For the time being, it necessary to ”Quit” and restart Persint to change the Magnetic field file.
4To get automatic access to these files, open the port with the following command:

ssh -D 3128 lxplus.cern.ch



57 10 EXERCISE 5: ATLAS PHYSICS EVENTS (1)

tool bar.
Then we load the necessary files with the Data manager icon of the File tool bar, following
the indications given in figure 4:

• The (default) amdb simrec.xxx geometry file in the Volumes tab (Fig. 4a).
Check the box ”Load AGDD Volumes from the AMDB file”

• The (default) magnetic field file in the Magnetic Field tab (Fig. 4b).

• The (default) Muon hits file in the Events tab (Fig. 4c).
Load also the (default) Data Cards file.

- To display the event of the default Event file (Out.MboyView Zmumu4023) 1 click
on the Next event icon of the Event tool bar. The muon chambers which contain hits Next event

(and only those chambers) are displayed.
- To display the reconstructed tracks, click on the Athena reconstruction icon of the

Event tool bar. A second click will remove the tracks. Athena-
reconstruction- The Simulated tracks icon can be used to visualize generated tracks. A second click

will remove those tracks.
- The muon chambers belonging to the event can be hidden by un-selecting Chambers

in the Event menu.
Simulation-
tracks

(a) Display of Event 4023 showing tracks
and the chambers containing hits

(b) The Set track parameters win-
dow

Figure 51: Display of Event 4023 resulting from the selections made.

After having used some functions of the Navigation tool bar to change the aspect of the
display, figure 51a shows the event with the two muon tracks and the chambers which
contain hits.
Many different reconstructed objects can be displayed; they are selected in the Set track
parameters window (Fig. 51) 2 available through the corresponding icon. Set track parameters

For instance, one can choose to display tracks reconstructed by Muonboy or Moore,
Staco or Muid etc. . .
Besides these objects specific to the muon system, it is possible to visualize objects
relevant to the calorimeters (cells) and Inner Detector (tracks). These displays will be
discussed in section 11.3.
Note that the Event can be erased from the display with the Clear event function. Clear event

1The file ”Out.MboyView Zmumu4023” used in this tutorial contains only one event.
2See also figure ?? in Appendix E.5.1.
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10.3 Select Sectors to be displayed

Because all chambers with hits are displayed in an event, the display may become
crawded. Although this is not the case for the current event 4023, we will nonethe-
less clear the display of the chambers which do not have a reconstructed track .
First we identify the sectors of interest: by moving the cursor over the 6 chambers which
contain the two reconstructed tracks, we find that the two sectors concerned are sectors
3 and 7, as indicated by the chamber labels. The goal is now to only display those
sectors 3 and 7.
To do this, we use the function Select Sectors. . . of the Events menu. In the window
which appears, we choose the sectors we want to display, by using the

�� ��Add button
shown in figure 52a. In the pop-up window, make the selections to display sectors 3,
as shown in figure 52b; repeat the operation for sector 7. Upon clicking on

�� ��OK , the
selection is displayed in the Select sector(s) window (Fig.52c). Clicking once more on�� ��OK will produce the event display of figure 52 where only sectors 3 and 7 are displayed.

(a) Select sector(s) window (b) Edit sector(s) window (c) Selections made

Figure 52: How to select the sectors to be displayed in an event.

(a) Display of Event 4023 showing all
chambers containing hits

(b) Display of Event 4023 showing only
chambers in sectors 3 and 7

Figure 53: Event 4023, display (2), resulting from the selection of two sectors.

The selection of sectors remains active until another selection is made in the Select sector(s)

window or until one restores the entire display, using the
�� ��Reset button of that window.

Note that figures 53a (default) and 53b correspond to the selections of figures 52a and
52c, respectively.
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10.4 Dressing the event

It is often convenient to ”dress” the event with surrounding detectors in order to get a
sense of orientation in ATLAS. This is particularly true for displays destined for pre-
sentations or publication. One can add the detector elements useful for orientation and
change the aspect of the display at will. To do this, we use the Selector window and the
Navigation tool bar as explained in section 7.

For this exercise, we will again load the predefined detector file for this event: click
on the Open view icon of the File toll bar and select Zmumu4023.p2vf in the directory Open view. . .

Persint-00-02-••/example. The display now resembles figure 54a.

We want first to change the aspect of the display. In order to ensure fast processing
of each action and to get optimal fluidity in the displacements, we turn to the global
Wire mode (see section 9.6, item 1) by clicking on the relevant icon in the Image tool
bar. The display of figure 54b is obtained.

Wire mode

We now Zoom-out and Rotate the view using the navigation tool bar as explained in
section 8 to obtain a display resembling figure 54c.

To obtain the display in full volume mode, we click again on the Wire mode icon to
obtain figure 54d.

(a) Event 4023 dressed with the default file
Zmumu4023.p2vf

(b) Event 4023 in Wire mode

(c) Event 4023 rotated and after Zoom-out (d) Event 4023 in full display mode

Figure 54: Display of Event 4023 resulting from the selections made.

In this view, the event itself is partially hidden. To remedy this, we will drop some
elements of the detector to be displayed. First we remove the endcap toroids by un-
checking the relevant item in the AMDB tab of the Selector window and we also remove
the lower coil of the barrel toroid by selecting the four left-most coils. Remember that
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the color of the detector items (e.g. the barrel toroid) can be chosen in this pane. These
modifications are indicated in figure 55b.
We now remove the feet and the shielding by making the appropriate selection in the
AGDD pane of the Selector window, as indicated in figure 55d.

(a) Initial status (b) Modified status (c) Initial status (d) Modified status

Figure 55: Modifications made in the Selector window.

After the selections have been made, click on the Compute icon of the Image tool bar.
ComputeA view similar to figure 56 is displayed.

To return to the bare event display (without the ”dressing”), use elements of the
Clear view function to remove AMDB and AGDD volumes.

Clear view

Figure 56: Display resulting from the modifications made to the selected detector ele-
ments. Track labels were produced as indicated in section 9.1.2.
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(a) AMDB geometry file (b) Magnetic field file

Figure 57: Warnings issued by Persint about loading the proper files.

10.5 Save the view

By clicking on the Save view as icon in the File tool bar the view displayed in the main dis-

Save view as. . .

play can be saved as a .p2vf file to the directory of your choice, e.g. Persint working files.
This file (e.g. exercise5.p2vf) can be retrieved for later use in Persint via the Open view
icon.
The view can also be exported or printed as explained in section 6.4.

10.6 Changing the event file

We now want to use a different event file. In the File menu (or tool bar), choose Data

manager and then the Event tab and click on
�� ��Load . Choose the file ”Out.MboyView Top evts 5”

of the Persint-00-02-••/example directory. Persint issues a warning and invites you to

load the appropriate geometry file (Fig. 57a): answer
�� ��Yes in order to load the correct

file. A second warning is issued (Fig. 57b) which invites you to load the appropriate

magnetic field file. Again, answer
�� ��Yes .1 The loading of the appropriate files takes

several seconds.

The panes Events and Magnetic field now display the current files which are used, and
also the default files (Fig. 58). 2

10.7 Scanning events

Persint is well adapted for scanning events. To illustrate how the scanning works, we
shall load a file which contains many events (unlike Out.MboyView Zmumu4023 which
has only one event).
In the Event tab of the Data manager window (Fig. 4c), click on

�� ��Load in the Muon
hits file part. In the pop-up window, choose Out.MboyView 1 in the Persint-00-02-
••/example directory, a file of simulated single muon events. Depending on the previ-
ously loaded event file, two consecutive warnings, similar to figure 58, are issued about
geometry and magnetic field files. Choose the suggested files by answering

�� ��Yes . Close
the Data manager window.

1It is possible to use geometry and field files different from the recommended files, by answering
�� ��No .

This may be needed in special cases.
2Note that the current file can be defined as the default file by clicking on

�� ��Define as Default .
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(a) ”Current” Event file

(b) ”Current” Magnetic field file

Figure 58: ”Default” files and ”Current” files being used by Persint.

10.7.1 Manual scanning

Click on Next event to display the first event of the file. Next event

The event number is # 3998 and is displayed in the Event number scale
of the Event tool bar. Event number scale

Click on Next event to display the following event.
The details of the event visualization can be defined using a series of functions of the
Events menu (e.g. Athena reconstruction, Hit calorimeter cells, Strips, Tubes etc.) 1.

Any event can be chosen directly from the Event number scale. It can also be entered
with the keyboard.
The Reload event icon is used to load the current event again.

Reload event

10.7.2 Automatic scanning

The scanning can be performed automatically with the Start autoscan icon.
Start autoscan

Autoscan speed
The Autoscan speed icon makes it possible to choose the time between events
(1, 2, 5, 10, 20, or 30 seconds). The change of speed can be made ”on the fly”.

If one wants to work with a given event, the automatic scanning can be interrupted with
the Start autoscan icon which has now changed aspect (Stop autoscan).

Stop autoscan

10.7.3 Visualization properties

By default, each visualization of a new event is done from a predefined perspective. How-
ever, when scanning events, it may be convenient to retain the current (modified from
the default) visualization properties. This is done with the Store visualization properties
icon.

Store visualiza-
tion properties

1See Appendix E.5
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To illustrate this feature, we go back to the first event (#3998) of the loaded event file
by choosing the event number in the Event number scale. Display the reconstructed
tracks using the Athena reconstruction icon (Fig. 59a).

Athena-
reconstruction

Now we use the navigation tools to change the visualization properties. First we zoom-
out and display the ATLAS coordinate axes by choosing Huge axes in the Axes menu
(Fig. 59b).

Axes

(a) Event 3998: initial default visualization properties (b) Event 3998: after zoom-out and with axes

Figure 59: Various views of Event 3998

Let’s rotate the view to obtain figure 60a. We assume that the Store visualization prop-
erties icon is enabled. Clicking on the Next event icon will display event #3999 with the
stored visualization properties (i.e. the rotated view). These parameters are used until
the Store visualization properties icon is disabled and the next event #4000 is displayed
(Fig. 60b).

(a) Event 3998: after rotation (b) Event 4000: Back to initial visualization
properties

Figure 60: Events 3998 & 4000

This feature of changing the visualization parameters can be used ”on the fly” in the
Autoscan mode.
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10.7.4 Using 2D projections

For scanning purposes, it may be useful to use a two-dimentional projected view of the
events:

• Stop the autoscan with a click on the Stop Autoscan icon. Stop autoscan

• Display the X-projection by clicking on the appropriate item of the Projection
menu.

Projection

• Resume the automatic scanning with the Start autoscan function. All events are
now displayed in the X-projection until the Store visualization properties function
is disabled to return to the initial 3D view, or the Stop autoscan function is used
to end the automatic scanning.

Figure 61 shows two events captured during the automatic scanning with the X-projection
enabled. Note that the display of the axes can be disabled at any time by choosing
No axes in the Axes menu.

Axes

(a) With coordinate axes displayed (b) Without Coordinate axes

Figure 61: X-projection of scanned events
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11 Exercise 6: ATLAS Physics events (2)

In this exercise, we will examine more features provided by the Events menu. They
concern the data from the muon spectrometer, the calorimeters, and the Inner Detector.
Remember that it may be convenient to save the display as a .p2vf file (e.g. in your
Persint working files directory) if you must interrupt your work. This is done with the

Save view as. . .
Save view as function, as explained in section 6.4.

11.1 Muon spectrometer data

Again, as in exercise 5, we start from scratch. After starting Persint, we erase the display
window with the Clear button of the Image tool bar. Clear

Then we load the necessary files with the Data manager icon of the File tool bar, following
the indications given in figure 4:

• The (default) amdb simrec.xxx geometry file in the Volumes tab (Fig. 4a).
Check the box ”Load AGDD Volumes from the AMDB file”

• The (default) magnetic field file in the Magnetic Field tab (Fig. 4b).

• The (default) Muon hits file in the Events tab (Fig. 4c).
Load also the (default) Data Cards file. This file is needed to enable the interactive
muon reconstruction with Muonboy.

To display the event of the default Event file
(Out.MboyView Zmumu4023) a click on the Next
event icon of the Event tool bar. The muon cham-
bers which contain hits (and only those) are displayed
in the figure to the left.

aThe file ”Out.MboyView Zmumu4023” used in this tutorial
contains only one event.

Next event

11.1.1 Map (η, ϕ) of expected number of stations

The number of detector stations which a particle encounters on its path depends on
its initial direction. The number of stations crossed by a track is calculated along a
straight line originating at the IP and following the η, ϕ direction. A map (η, ϕ) of this
population can be obtained with the feature described below.
In the Tools menu, choose Histograms. . . /Number of expected stations. In the pop-up
window ”Select options for map”, make the following selections :

- Lattice in η, ϕ

- Type : select precision stations (MDT+CSC) or trigger stations (RPC+TGC)

- Selection : use all stations in the spectrometer or only the stations being displayed

A possible selection of parameters is shown in figure 62a; the resulting map of the number
of expected stations as a function of η, ϕ is shown in figure 62b.
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(a) Selecting options for display (b) Map of expected number of stations

Figure 62: Map of expected number of stations

11.1.2 ATHENA reconstructed segments and tracks

Now we want to display the reconstructed tracks in the muon spectrometer.

1. First we choose the parameters of the tracks to be displayed by opening the Set
track parameters window. We replace the default values by the following:

Set track parameters

• Ignore ”Simulation” and ”Calorimeter Cells” for now

• Check ”Muonboy segments” (or Moore segments)

• Check ”Muonboy tracks at spectro” (or Moore segments)

• Select the ”Track shape”: Ribbon, Crossed ribbons, or Cylinder.

• Set ”Track width” to a value around 0.30

The resulting Set track parameters window is shown in figure 63a.
Close the window by clicking on

�� ��OK , then click on the Compute icon.
Compute

Athena-
reconstruction

To visualize the reconstructed tracks, click on the Athena reconstruction icon and
obtain figure 63b.

(a) Selections made in the Set
track parameters window

(b) Display of reconstructed Muon-
boy tracks

Figure 63: Event 4023 (first pass)
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2. We will now label the tracks. Select the Default mode in the Navigation tool bar.

Default mode

Move the cursor over the first track, right-click and choose Add cutomized
label. In the pop-up window, un-check the two coordinate boxes and choose the
SW position (Fig. 64a). Click on

�� ��OK .
Repeat this operation for the second track to obtain figure 64b.
The labels indicate the charges and momenta (in GeV/c) of the reconstructed
tracks.

(a) Selections made in the Set track parameters window (b) Display of reconstructed tracks
with labels

Figure 64: Event 4023 (second pass)

3. We may want to save the display into the directory (Persint working files) as a
.p2vf file, for future use with Persint, using the Save view as ... function.

Save view as. . .

Remember that the Export view as ... can be used for saving the display for
presentations as a (e.g. .jpg) file, with the possibility of adding captions, logos or
pictures (see sections 6.4 and 6.5).

(a) Selections made in the Set track
parameters window

(b) Display of reconstructed MuID tracks

Figure 65: Event 4023 (third pass)
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4. As can be seen in the Set track parameters window, one can choose other objects
to be displayed. For example, the choices: ”Moore segments” and ”MuID extra
tracks” shown in figure 65a result in figure 65b, once the customized labels have
been added as before.

5. Instead of showing the tracks, one can choose to display only the segments. To
do this, open the Set track parameters window and select only the Muonboy or
Moore segment box (or both), as shown in figure 66a. We look now at the upper
triplet of detector stations. After rotating the display and zooming-in, we obtain
figure 66b.

(a) Selecting segments in the Set
track parameters window

(b) Display of reconstructed segments (in
red)

Figure 66: Event 4023 (fourth pass)

6. We now choose different settings of the ”MDT options” shown in figure 67a, we
rotate the view, and we zoom-in on the BML chambers with the Zoom on custom
area function discussed in section 8.3, item 4. We obtain figure 67b, where one
recognizes the hit MDT tubes (in red), the active RPC strips (in yellow) and
the reconstructed segment (in red). The labels have been added as explained in
section 9.1.2.

(a) Selecting MDT options in the
Options pane

(b) Display obtained with the settings shown in figure 67a

Figure 67: Event 4023 (fifth pass)
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7. We choose now the X-projection in the Image menu. In the Set track parame-
ters window, make the selection shown in figure 63a (Reconstructed segments and
tracks). The MDT options are again shown in figure 68a. After zooming, we obtain
figure 68b where labels (section 9.1.2) and a caption (section 6.5) have been added.
The red square is the location of a scattering center along the reconstructed track.
Multiple scattering is computed at that location, using the track momentum and
the average amount of surrounding material.

(a) Selecting MDT options in the
Options pane

(b) X-projection of reconstructed tracks with the settings shown in
figures 63a and 68a

Figure 68: Event 4023: Zoomed X-projection with reconstructed tracks

8. Finally, selecting segments instead of tracks in the Set track parameters window,
according to figure 66a, and choosing the MDT options of figure 69a, we obtain the
display of figure 69b.

(a) Selecting MDT options in the
Options pane

(b) X-projection of reconstructed segments with the settings shown
in figures 66a and 69a

Figure 69: Event 4023: Zoomed X-projection with reconstructed segments
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11.1.3 Simulated muon tracks

This exercise is only valid for simulated events !

• Start with an empty main display by using the Clear view function.
Clear

• Load the previous event again (Event 4023) with the Reload event function.
Reload event

• Open the Set track parameters window and make the following additional selec-

Set track parameters

tions: Generate tracks at IP and Only muons so as to obtain the overall selections
of figure 70b.

• Click on
�� ��OK to close the window.

• Validate the selections by clicking on the Compute icon.
Compute

• To visualize the generated tracks, click on the Simulation tracks icon. The

Simulation tracks

simulated tracks appear (from the IP).

• Click on the Athena reconstruction icon and the reconstructed tracks appear

Athena reconstruction

superimposed on the simulated tracks, as expected for a successful reconstruction
(Fig. 70c).

(a) Selections in the Set track
parameters window (Reconstruc-
tion)

(b) Selections in the Set track pa-
rameters window (Simulation)

(c) Display of simulated and recon-
structed tracks

Figure 70: Event 4023 (sixth pass)

11.1.4 Interactive reconstruction with Muonboy

We start again with Event 4023 of the Out.MboyView Zmumu4023 file. Make sure all
necessary files are loaded by using the Data manager windows. In particular the Data
cards file and Magnetic field file need to be loaded as indicated in figures 4b and 4c
on page 20. Use the default files for this exercise. Click on the Muonboy interactive
reconstruction icon. Two reconstructed candidate tracks are displayed.

Muonboy
interactive
reconstruction

We now make a customized label for each candidate (see section 9.1.2) and obtain
figure 71.
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Figure 71: Display of two candidate tracks

For each candidate track which is displayed, the Muonboy pane at the bottom left of
the Persint display shows the characteristics as seen in figure 72. This pane also shows
a warning if no muon could be reconstructed. 1

Figure 72: The parameters of each muon candidate
are shown in the Muonboy pane. They include the
signed momenta of reconstructed muons, the track
fitting parameters, and the invariant mass of a muon
pair.

We will now repeat the interactive reconstruction of the muons with a magnetic field of
half the intensity of the default file (bmagatlas05 test2.data).
Retrieve and load this new magnetic field file in the following way:
− Open the Data manager window of the File menu and click on the Magnetic Field tab. (see

figure 4b, page 20).
We must first download the new magnetic field from a location at CERN 2. This is done by
clicking on

�� ��Download. . . 3. In the Download extra field maps . . . window, select the file

bmagatlas05 test2 10250Amp.data.gz from the list and hit
�� ��OK . This file is automatically de-

compressed and copied to the local ”Persint-00-02-••/BFieldData/share” directory.
Back in the Data manager window, select the new file now proposed in the ”Persint-00-02-••/BFieldData/share”

directory, and hit
�� ��Select so that the file becomes the current file. Finally, hit the

�� ��Load box.
− In the Events tab, load the Out.MboyView Zmumu4023 default event file and the muonboy collision cards.

− Hit the
�� ��Close window box.

Click on the Muonboy interactive reconstruction icon. Two reconstructed candidate
Muonboy
interactive
reconstruction

tracks are displayed. Again, the Muonboy pane shows the characteristics of the recon-
structed candidates. As expected, the momenta are indeed divided by ≈ 2, when the
field strength is halved (Fig. 73).

1e.g. an explicit message is issued if data such as alignment parameters of the A-lines are missing.
2Field maps are stored at: https://atlas.web.cern.ch/Atlas/GROUPS/MUON/magfield/Fieldmap.
3The new magnetic field can also be downloaded by using the function Download. . . / Download extra

field maps of the File menu (see Appendix E.1).
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Figure 73: The parameters of each muon
candidate are shown again in the Muonboy
pane; with half the magnetic field strength, the
momentum is ≈ 2 times smaller

In the Muonboy window, the total invariant mass of all reconstructed muons is displayed.
A table containing the parameters of all reconstructed muons can be obtained by clicking
on the icon at the right hand side of the title bar, which makes it a floating window.
When this table (Fig. 74) is displayed, a right-click on the content will offer the Copy
to clipboard function which can be used to save the reconstruction data in a text file.

Figure 74: The Muonboy window,
with a table of all reconstructed
muons. The total invariant mass
is given at the top, the invariant
mass of the chosen muon(s) at
the bottom. The Copy to clip-
board function is obtained by
righ-clicking on the table.

The boxes at the bottom of the window make it possible to calculate the invariant mass
of any number of muons by making the appropriate selections. In figure 74 with one box
checked, the invariant mass is the muon mass. Again, the table may be copied to the
clipboard and saved.
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11.1.5 Color code for MDT hits

The interactive reconstruction can be used to look at the reconstruction process in de-
tail.
We start again with Event 4023 of the Out.MboyView Zmumu4023 file. Make sure all
necessary files are loaded by using the Data manager windows. In particular the Data
cards file and Magnetic field file need to be loaded as indicated in figures 4b and 4c on
page 20. Use the default files for this exercise.
With the nominal MDT options (Fig. 75a), we obtain the display of figure 75b.

(a) Nominal MDT options (b) Event 4023

Figure 75: Event 4023 without reconstruction

We now choose the X-projection with the Projection menu, and zoom on the BIL cham-

Projection

ber indicated by a label to obtain figure 76b which uses the MDT options of figure 76a.

(a) MDT options (b) MDT hits before reconstruction (red)

Figure 76: Event 4023: Detail of BIL chamber in the X-projection
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The reconstructed track is obtained by clicking on the Muonboy interactive reconstruction
Muonboy
interactive
reconstruction

icon (Fig. 77).

Figure 77: MDT hits after reconstruction (black)

The color code for MDT hits is the following: black hits are those selected by the pat-
tern recognition, red hits do not belong to a track (all hits are selected by the pattern
reconstruction in figure 77).
The interactive reconstruction can be used to act on the event characteristics to un-
derstand which role they play. For instance, a hit MDT tube or a RPC strip can be
removed with the Move volumes to infinity (see section 9.2). Then, when re-running the
reconstruction algorithm, the removed tube or strip will not be taken into acccount.
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11.2 Vertex display and Inner Detector data

The primary vertex as well as secondary vertices are available for display. Histograms
of primary vertices can also be produced.
The primary vertex is obtained by a fit of all reconstructed Inner Detector tracks. Like-
wise, the secondary vertices are obtained from an analysis of the ID tracks.
The default settings in the ATHENA job options produce the primary vertex candidate
in the Persint event file OUT.MboyView xxx, as seen in Appendix D.3.7: the line VTX
appears seven lines before END EVT line.
To obtain the secondary vertices in OUT.MboyView xxx, the proper job options need to
be chosen when running the reconstruction programs in ATHENA.

11.2.1 Vertex display

• Start with an empty main display by using the Clear view function. Clear

• Load the previous event again (Event 4023) with the Reload event function.
Reload event

• To best illustrate this function which displays the vertex, we will first display the
Inner Detector tracks:
Open the Set track parameters window and make the selections shown in figure 78.

Set track parameters

In particular, check the “ID tracks at IP” box.1

Figure 78: Selection made in the Set track parameters window to display Inner Detector
tracks at the IP.

1Note that it is not necessary to display the Inner Detector tracks in order to display the primary
vertex.
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• Click on
�� ��OK to close the window.

• Validate the selections by clicking on the Compute icon.
Compute

• Click on the Display vertex candidates icon of the event tool bar.

Display vertex
candidates

In the window which opens, choose the Vertex display options: check the Primary
vertex box and choose the size and color of the sphere which represents the primary
vertex.

(a) Vertex Display Options (b) Display of Inner Detector (blue) and muon (black) tracks,
and the primary vertex in red.

Figure 79: Display primary vertex.

• Click on
�� ��OK to close the window.

• Zoom on the vertex region and obtain figure 79, with the Primary vertex displayed.

11.2.2 Histogram of d0 (primary vertex)

A histogram of the primary vertex candidates in an event is obtained by clicking on
the item Histogram of d0 distribution in the Events menu (See Appendix E.5). The
histogram can be saved in various formats [.png, .gif, .ps, .eps, .pdf, .C (ROOT macro)].

Figure 80: Histogram of d0: distribution of primary
vertex candidates for a 7 TeV collision event.
Each Inner Detector track has an associated d0.
(Run 155678, Event 13304729)
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11.3 Calorimeter data

11.3.1 Display calorimeter hits

• Start with an empty main display by using the Clear view function. Clear

• Load the previous event again (Event 4023) with the Reload event function.
Reload event• Open the Set track parameters window and choose the default values by clicking

Set track parameters

on
�� ��Restore defaults . The selections should be those in figure 81.

(a) Selections for Reconstruction (b) Selections for Calorimeter cells

(c) Selections for Simulation (d) Selections for E/G objects

Figure 81: Selection made to obtain the display of figure 82

• Click on
�� ��OK to close the window.

• Validate the selections by clicking on the Compute icon.
Compute

• To visualize the reconstructed muon tracks, click on the Athena reconstruction
icon.

Athena reconstruction

• To visualize the calorimeter cells which have a signal, click on the Hit calorimeter
cells icon.

Hit calorimeter cells

• To dress the display with some detectors, make the selections in the AMDB pane of
the Selector window, as shown in figure 82a.
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Figure 82b is the result of these these selections and shows the reconstructed muon tracks,
the calorimeter cells with hits and two sectors of the calorimeters and inner detector.

This display may now be saved for future use: click on the Save view as. . . icon and save
Save view as. . .the file as exercise6-Calo-low-thresholds.p2vf in your Persint working files direc-

tory.

(a) AMDB selection pane (b) Calorimeter hits (low thresholds)

Figure 82: Display of event 4023 with two reconstructed muon tracks, and hit calorimeter
cells: electromagnetic liquid argon in red, [hadronic Tile, endcap, and forward calorime-
ters] in purple

11.3.2 Display calorimeter hits with increased thresholds

1. Display bare calorimeter hits

Starting with the display of figure 82b 1, we now change the thresholds for display-
ing calorimeter hits, as they were set very low in the default settings.
Open the Set track parameters window and change the values according to

Set track
parameters

figure 83.
Instead of setting the parameters by hand, you may load the prepared Track

parameter file which we already used in section 6.1.2, item 3. Click on
�� ��Open

and select Zmumu4023.p2ts in the Persint-00-02-••/example directory. Click on
Compute�� ��OK and then on the Compute icon. Activate the Athena reconstruction and Hit

Athena
reconstruction

calorimeter cells icons to obtain the display of figure 84.

Hit calorimeter cells

Note that the dressing with calorimeter and Inner detector sectors has been re-
moved by clicking in the center of the three wheels of figure 82a.

Note also that since the ”ID tracks at IP” box is checked with a 0.5 GeV/c thresh-
old (Fig. 83), Inner detector tracks are displayed as well.

1In case the work was interrupted, remember that the display was saved as a .p2vf file.



79 11 EXERCISE 6: ATLAS PHYSICS EVENTS (2)

(a) Selections for Reconstruction (b) Selections for Calorimeter cells

(c) Selections for Simulation (d) Selections for E/G objects

Figure 83: Selection made to obtain the display of figure 84

Figure 84: Display of
event 4023 with in-
creased thresholds for
calorimeter hits: essen-
tially 2 GeV in for-
ward calorimeters. Re-
constructed Inner de-
tector tracks are also
displayed

2. Display calorimeter hits inside cell envelopes

In the Set track parameters window (Calorimeter Cells), check the Draw cell enve-
lope box and increase the threshold of ”LAr e.m. end-cap (EMEC)” to 0.5 GeV ,
and to 2 GeV for ”HEC” and ”FCal” (Fig. 85). Save the selections as a .p2ts file
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with the
�� ��Save box of the Set track parameters window.

Figure 85: Selection of thresholds and cell envelopes to obtain the display of figure 86

After making an X-projection and after some zooming, we obtain the display of
figure 86.

Figure 86: Display
of event 4023 (X-
projection) with
increased thresholds
for calorimeter hits
shown within cell
envelopes
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11.3.3 Histogram of calorimeter hits

Note that the use of the Histogram facility requires that the dependency for QtROOT
be satisfied (see Appendix B).
We start again with Event 4023 of the Out.MboyView Zmumu4023 file.
Open the Set track parameters window and choose

�� ��Restore defaults . Once the event
is displayed, click on the Histogram of hit calorimeter cells (also available in the Tools
menu). The histogram is displayed in figure 87 and shows the cell energy as a function

Histogram of . . .of Eta (Pseudo rapidity η) and Phi (Azimutal angle φ).

Figure 87: Histogram of hit calorimeter cells (low thresholds)

We now increase the thresholds of the cell energy in the Set track parameters window
as shown in figure 88.

Figure 88: Selection of high thresholds
in the Set track parameters window:
energy thresholds of LAr HEC and
FCal have been set to 20 GeV .
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To display the modified histogram, close the Set track parameters window by clicking
on the

�� ��OK box and then on the Compute icon. Compute

Finally, clicking on the Histogram of hit calorimeter cells icon two times, displays the
modified histogram (Fig. 89).

Histogram of . . .

Figure 89: Histogram of hit calorimeter cells (high thresholds)

Note that calorimeter cell thresholds may be set according to Energy or Transverse energy .
The selection is made via the Cut-off criterion box in the Set track parameters window. Cut-off criterion

The histogram can be resized or displaced at will by using the pop-up window obtained
by right-clicking on the title bar of the histogram window.
With Maximize, the histogram will occupy the entire area of the Main display.
With Minimize, the histogram is reduced to a ”tab” at the bottom of the display, and
can be retrieved with Restore. Aspect of histogram

Just as with previous maps ( 9.7.3, 9.8, and 9.9), the histogram can be exported as an
ASCII file (.dat format) with the

�� ��Export button.

The histogram can be saved by clicking on the
�� ��Save box. A number of formats are

proposed, as shown in figure 90.

Figure 90:
File formats proposed when saving the Histogram of
hit calorimeter cells

Note that, when scanning events (see section 10.7), the histogram is automatically re-
freshed when a new event is displayed.
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12 Persint: a versatile tool

12.1 An analysis tool

Many features of Persint can be used for illustrating the properties of the muon spec-
trometer. For example, the Generate muon tracks function is a convenient tool for
studying the behavior of muons in the spectrometer. In the early collision data of 2009,
a charge asymmetry of low energy muons was spotted in the forward regions.

Figure 91: Scatter plot
showing the µ−/µ+ asym-
metry: µ− are more nu-
merous in the η > 0 re-
gion, whereas µ+ are more
numerous in the η < 0
region. This is true for
900 GeV collision data
and Monte Carlo events.

The effect has its explanation in a rather subtle acceptance property of the spectrometer
for positively and negatively charged muons. Persint was used to illustrate this behavior
[8].

Figure 92: Illustration of the charge asymmetry of forward low energy muons in 900 GeV
collision data. The intricate acceptance effect is illustrated with generated positive (red)
and negative (blue) muons in the forward regions.
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The muons of figure 92 have been generated with the parameters shown in the Generate
muon tracks window of figure 93: P = 10 GeV and | η |∈ [2.5, 3.0]

Figure 93: List of muon tracks generated in figure 92. Muons of momentum P = 10 GeV
have been generated at the IP and propagated through the calorimeters, using the Gen-
erate muon tracks function (section 7.1)
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12.2 Study of the geometry and dead material

Persint has been used to optimize the muon spectrometer throughout the design phase.
At present it is the tool with which the most recent layout and the dead material content
of ATLAS support structures are being introduced into the geometry discription used
by the reconstruction software.
As an example, the latest barrel toroid cryotube structure has been introduced into the
geometry. With this study using Persint the primary numbers entering the geometry
data base have been updated.1

Figure 94: Using Persint for the geometry description: the modified volumes are visual-
ized and the primary numbers are entered into the data base.

1The GEOMODEL in particular uses these primary numbers.
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13 Selected event displays

Figure 95: Min Bias event in 900 GeV data: Run 141749, Event 113661. (December, 2009)

Figure 96: Min Bias event in 900 GeV data: Run 141749, Event 171059. (December, 2009)
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Figure 97: A J/Ψ→ µµ candidate in the 7 TeV collision data of 2010.

Figure 98: The same J/Ψ→ µµ: in 2D projections and details of track reconstruction.
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Figure 99: A W → µν candidate in the 7 TeV collision data of 2010.

Figure 100: The same W → µν candidate: in 2D projections and details of track reconstruction.
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14 Useful hints

1. Compute
The effect of the Compute icon is to make all computations necessary to display
an event, after changes have been made to the parameters.
Actionning Compute is not always necessary:

For example, after closing the Set track parameters window by clicking
on

�� ��OK , it is necessary to validate further with Compute. On the

contrary, after closing the Generate muon tracks window with
�� ��OK , it

is not necessary to use Compute.
There is no general rule for using the Compute action. When in doubt,
it is always prudent to use it.

2. Interrupt/resume your work
It is important to realize that it is possible to interrupt and resume your work at
any time. In case Persint cannot be left idle during the pause, you can save the
files used by the program as specific ASCII files. The relevant files (described in
Appendix D) are:

• The .p2vf file
It contains everything necessary 1 for displaying the current view of the Main
display (see section 6.4, item 1). The file is saved with the Save view as. . . Save view as. . .

icon, and retrieved with the Open view icon.
Open view• The .p2gm file

This file contains the parameters of the tracks generated with the Generate
muon tracks icon (section 7.1). The file is saved from within the Generate

muon tracks window by clicking on the
�� ��Save box.

• The .p2ts file
This file contains the parameters of the Set track parameters window (Appendix E.5.1).
These parameters define the objects chosen for display in an event (Tracks,
segments, MDT, RPC, ID hits, calorimeter hits, electrons, photons, etc.), as
well as their energy or momentum thresholds. The file is saved from within
the Set track parameters window by clicking on the

�� ��Save as. . . box 2.

3. Previous view
When modifying the aspect of a view with the navigation tools, is is sometimes
difficult and time consuming to go back to a previous display which seemed satis-
factory. The Previous view icon makes it possible to retrieve up to ∼ 100 displays

Previous view

backwards.

1Labels and captions are saved but pictures (e.g. the ATLAS logo) are not.
2The

�� ��Save box saves the file and makes it the default file.
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15 APPENDICES

A Architecture

Persint, the detector and event display for the ATLAS muon spectrometer originally
conceived by Marc Virchaux, now has a new Graphical User Interface developped withQt.
This appendix gives a short description on how the software source code is organized.

• Software development philosophy

Figure 108: Architecture of the Persint source code

As shown in figure 108, the source code is divided into 3 distinct parts :

1. The core corresponds to Fortran code, e.g. algorithms for computing hidden
faces, routines for reading input files, and so forth...

2. The ”wrapping” layer, written in C++, is a communication layer between the
program core and the graphical interface. It is made of classes encapsulating
the calls to Fortran routines.

3. The C++ code for the Graphical User Interface (GUI).

Thus, there is no direct call to Fortran core routines from the GUI as they are only
called by the wrapping layer. Wrapper classes are organized by topics, e.g. one for
views, one for AMDB volumes, etc...

• File organization
Most source files created for the new interface are located in one of the following
three directories :

1. PersintCore/persint2 core
This directory contains all Fortran routines called by the ”wrapping” layer.
Most of theses routines have been written specifically for the new GUI and
are code fragments extracted from the initial HIGZ-based version of Persint.
Like wrapper classes, these routines are organized by topics. For example, all
methods dealing with AMDB volumes are gathered in file wrap amdb.FF90.
Moreover, each routine name is prefixed with a string identifying its topic :
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AMDB volume related routines start with ”AMDB ”, etc. ... Files whose
name does not start with ”wrap ” only contain routines called from other
Fortran routines, not directly from the wrapper classes.

2. Persint2Core
This directory contains C++ header (.h) and source (.cpp) files respectively
defining and implementing all wrapper classes. Each wrapper class in this
directory is associated with a Fortran file in the PersintCore/persint2 core
directory. The only constructor in each of these classes has the ”protected”
attribute, so that the only way to actually instantiate a wrapper class - and to
access its methods - is by creating a derived class. These wrapper classes have
been implemented so that, whenever possible, they use standard C++ libraries
rather than Qt-specific tools. This directory also contains classes required by
the GUI but without calls to Fortran routines (e.g.: ColorF, persint::Colors,
FCString, . . . ).

3. PersintGui
This directory contains all Qt classes developped for the new interface. Files
with .ui extension are XML files created with the Qt designer and describing
widgets. They should be edited with the designer-qt4 executable. The direc-
tory also contains .h and .cpp files implementing classes derived from Qt wid-
gets. These classes inherit from wrapper classes as is necessary for interacting
with the core of the application. For instance, the persint::AmdcVolumeTree
class inherits from the persint::Amdb wrapper class in order to be able to
access functions related to AMDB volumes. Files ending with moc.cxx or
ui.h are generated automatically by Qt tools during compilation and should

not be edited by hand.

• Sample ASCII files
The various files used by Persint are listed and described in Appendix D. They
include files which contain all the information about geometry, detector description,
magnetic field, events, track parameters, generated muons, etc.
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B Installation and dependencies

The latest release of Persint is : Persint-00-02-27. This version number is used
throughout these instructions. Check for the latest version at:

https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki
and change the commands accordingly (e.g. replace 00-02-27 by 00-02-n, where n is the
latest release number).
Older releases can be found at:
http://atlas.web.cern.ch/Atlas/GROUPS/MUON/Persint/releases/

The running of Persint is dependent on a number of libraries which need to be installed
beforehand. Satisfying these dependencies involves procedures which depend on the
platform. On the contrary, the installation of Persint proper is common to all platforms.
The complete procedures 1 are described below for reference.

However, for easy installation and up-to-date instructions, consult the Twiki page
https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki

and use copy-paste operations.

Bugs, comments, installation problems, or questions can be reported to :
https://groups.cern.ch/group/atlas-sw-persint-support/default.aspx

B.1 Installation

B.1.1 Tarball (default procedure)

Download and install the complete source tarball (15 MB).

wget http://atlasinfo.cern.ch/Atlas/GROUPS/MUON/Persint/releases/00.02.27/
src/Persint-00-02-27.tar.gz

tar xvfz Persint-00-02-27.tar.gz

cd Persint-00-02-27

./configure

make -j3

./start persint.sh

Warning: the above instructions assume all dependencies are satisfied.

B.1.2 SVN

Download code from source repository and install, as follows.

After configuring subversion, checkout the Persint source code. From the Persint direc-
tory, run the bootstrap.sh script to download other required Atlas software compo-
nents. You can then start compilation with ”make”.
After you are done, simply run the .start persint.sh script, that will set your library
and binary paths and run the program.

1When updating to a new version of Persint, it is usually sufficient to do only the installation without
repeating the part concerning dependencies.
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export SVNROOT=svn+ssh://svn.cern.ch/reps/atlasoff

svn co $SVNROOT/graphics/Persint/tags/Persint-00-02-27 Persint-00-02-27

cd Persint-00-02-27

./bootstrap.sh

make -j3

./start persint.sh

Warning:

• The above instructions assume all dependencies are satisfied.

• Subversion configuration: if your local username is different from your lxplus
username, you may need to specify the latter in your $HOME/.ssh/config file.
For details, see:
https://twiki.cern.ch/twiki/bin/view/Atlas/SoftwareDevelopmentWorkBookSVN
#Access to the SVN repositories.

B.1.3 Ubuntu

Install Ubuntu Persint package.

Persint is available as an Ubuntu package on a dedicated repository. The procedure
below can be found at:
http://sizun.web.cern.ch/sizun/persint/ubuntu.html.
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B.1.4 lxplus

Run the pre-installed version of Persint on lxplus.
If you have an account on the lxplus network, you can run a pre-installed version of
Persint through AFS or SSH, though it might be a little slower:

ssh -X lxplus.cern.ch

\ln -sf /afs/cern.ch/atlas/www/GROUPS/MUON/Persint/releases/00.02.27/slc5-x86 64-gcc34/share/
Persint/start persint.sh

./start persint.sh

B.1.5 CernVM

1. Install Persint on CernVM:

• Go to the page https://twiki.cern.ch/twiki/bin/view/Atlas/CernVM

• See also the VirtualBox page: http://www.virtualbox.org/wiki/Downloads

• The CernVM tutorial is at: https://twiki.cern.ch/twiki/bin/view/Atlas/
CernVMTutorialHead

2. Install OpenAFS

• Go to OpenAFS at: https://cernvm.cern.ch/portal/release 2.2.0

• Or type:
sudo conary update group-openafs-client openafs openafs-client

sudo mkdir -p /afs

echo cern.ch > /tmp/ThisCell

sudo cp /tmp/ThisCell /usr/vice/etc/ThisCell

and reboot your VM.

3. Setup Qt4

### 64 bits Machine

export PKG CONFIG PATH=/afs/cern.ch/sw/lcg/external/qt/4.6.3/x86 64-slc5-gcc43-opt/
lib/pkgconfig/:${PKG CONFIG PATH}

### or 32 bits Machine

export PKG CONFIG PATH=/afs/cern.ch/sw/lcg/external/qt/4.6.3/i686-slc5-gcc43-opt/

lib/pkgconfig/:${PKG CONFIG PATH}

4. Install Persint

• From source (tarball or subversion):
export SVNROOT=svn+ssh://svn.cern.ch/reps/atlasoff

svn co $SVNROOT/graphics/Persint/tags/Persint-00-02-27 Persint-00-02-27

cd Persint-00-02-27

./bootstrap.sh

make -j3

./start persint.sh

• Or install binary tarball (i686, x86 64):
### 64 bit Machine

wget http://atlasinfo.cern.ch/Atlas/GROUPS/MUON/Persint/releases/00.02.27/src/
Persint-00-02-27-slc5-x86 64-gcc41.tar.gz
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tar xvfz Persint-00-02-27-slc5-x86 64-gcc41.tar.gz

### 32 bit Machine

wget http://atlasinfo.cern.ch/Atlas/GROUPS/MUON/Persint/releases/00.02.27/src/
Persint-00-02-27-slc5-i686-gcc41.tar.gz

tar xvfz Persint-00-02-27-slc5-i686-gcc41.tar.gz

cd Persint-00-02-27

./configure

./start persint.sh

B.2 Dependencies

• Minimum requirements

1. Persint depends on Trolltech’s Qt 4 library ( 4.3.4).

2. Compilation also requires C++ and Fortran compilers, as well as standard
utilities such as pkg-config, head, sed, ...

• Optional dependencies

1. An optional additional dependency is QtROOT , e.g. the Qt plugin of ROOT,
used to display ROOT histograms within the Qt interface. The version of
QtROOT should be compatible with your version of the Qt4 library.

2. The Oracle Database Instant Client software development kit and the SOCI
C++ Database Access library are required for the application to be able to
download geometry files from the ATLAS database.

• Persint no longer requires either CERNLIB, HIGZ or LAPACK.

B.2.1 Ubuntu

• Mandatory dependencies
Install Fortran and C++ compilers:

sudo apt-get install gfortran

sudo apt-get install g++

Install Qt

sudo apt-get install libqt4-dev libmysqlclient15-dev

• Optional dependencies

1. Install QtRoot on Ubuntu

– Quick method:
Starting with Ubuntu 8.10 (Intrepid), QtRoot is directly available as an
Ubuntu package :
sudo apt-get install root-plugin-qt libroot-dev

– Recommented method:
However, for earlier Ubuntu versions (Hardy, Gutsy, ...) or for a more
recent version of QtRoot, you will need to build QtRoot yourself, using
the INSTALL QTROOT.sh script and following the official instructions 1:

1http://root.bnl.gov/QtRoot/How2Install4Unix.html
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(a) After installing Qt (e.g. the libqt4-dev package, see above), define
the QTDIR variable :
export QTDIR=/usr/share/qt4

(b) Download and run the installation script as follows:
export QTROOT INSTALL DIR=${HOME}/qtRoot;
mkdir -p $QTROOT INSTALL DIR

cd $QTROOT INSTALL DIR

wget http://root.bnl.gov/QtRoot/INSTALL QTROOT.sh

chmod u+x INSTALL QTROOT.sh

. ./INSTALL QTROOT.sh

The existing version of Qt package has been found under QTDIR=/usr/share/qt4
directory

Do you want to use it? (yes/no) yes

Do you want to proceed? (yes/no) yes

Do you want to install COIN3D also? (yes/no) no

(c) Set environment variables for Persint to locate QtRoot:
. ${QTROOT INSTALL DIR}/set environment.sh

Note: with the above command lines, QtRoot will be installed in ${HOME}/qtRoot.
If you prefer another location, set QTROOT INSTALL DIR accordingly.

2. Install the Oracle Instant Client SDK and the SOCI database access library
on Ubuntu

– Oracle Instant Client
(a) Go to the Oracle download page 1, in the Instant client section and

select the appropriate platform. Download the Instant Client Basic
RPM package and the Instant Client SDK RPM package. You will
need to create a (free) Oracle user account an to accept the license
agreement.

(b) Convert the RPM packages into debian packages :
sudo apt-get -y install alien

sudo alien -d oracle-instantclient-basic-<version>-<platform>.rpm

oracle-instantclient-basic-<version>-<platform>.rpm

(c) Install the generated debian packages and their dependency libaio :
sudo dpkg -i oracle-instantclient-basic-<version>-<platform>.deb
oracle-instantclient-basic-<version>-<platform>.deb

sudo apt-get -y install libaio1

(d) Define some environment variables to notify Persint of Oracle’s loca-
tion :
export ORACLE LIBDIR=/usr/lib/oracle/<version>/client/lib;

export ORACLE INCDIR=/usr/include/oracle/<version>/client;

The exact name of the installation directories will depend on your
platform.

– SOCI
wget http://downloads.sourceforge.net/soci/soci-3.0.0.tar.gz

tar xvfz soci-3.0.0.tar.gz

\rm soci-3.0.0.tar.gz

cd soci-3.0.0

1http://www.oracle.com/technetwork/indexes/downloads/index.html
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./configure --include-prefix=<prefix>/include --lib-prefix=<prefix>/lib
--oracle-include=$ORACLE INCDIR --oracle-lib=$ORACLE LIBDIR

make

make install

cd ..

\rm -rf soci-3.0.0/

You might encounter an error if the version of your Oracle client is recent,
as SOCI expects version 10. Just patch the SOCI source code before
compilation :
sed -i ’s;nnz10;nnz<version>;g’ build/unix/build-oracle.tcl

sed -i ’s;nnz10;nnz<version>;g’ src/backends/oracle/test/Makefile.basic

Inform Persint of the library’s location with an environment variable :
export SOCI HOME=<prefix>;

B.2.2 Debian

To install the minimal dependencies required for Persint under Debian Lenny :

sudo apt-get install gfortran g++ make pkg-config libqt4-dev libmysqlclient15-dev

You can then download and install Persint following the default procedure (section B.1.1).

B.2.3 Fedora

To install the packages required for installing Persint under Fedora 14, open a termi-
nal, acquire administrative privileges (with the su command) and execute the following
command line:

yum install wget pkgconfig gcc-c++ gcc-gfortran qt-devel xterm perl

You can then download and install Persint following the default procedure (section B.1.1).

B.2.4 Scientific Linux Cern

The release of Qt4 (4.2) provided by the qt4-devel SLC5 package is too old for Persint.
Hence, Qt4 needs to be installed from source.

• lxplus
The location of the Qt library on AFS will be automatically taken care of by the
Persint makefile and the start up script.

• Non-lxplus machine with access to CERN AFS directories

1. Qt is installed in the /afs/cern.ch/sw/lcg/external/qt/ directory. Choose
the appropriate version and add the path of the lib/pkgconfig subdirectory
to your PKG CONFIG PATH environment variable.

2. To activate the geometry data download feature, setup the Oracle Instant
Client and the SOCI library environments:
export ORACLE INCDIR=/afs/cern.ch/atlas/www/GROUPS/MUON/Persint/releases/opt

/oracle/instantclient10 1/sdk/include;

export ORACLE LIBDIR=/afs/cern.ch/atlas/www/GROUPS/MUON/Persint/releases/opt/
oracle/instantclient10 1;

export SOCI HOME=/afs/cern.ch/atlas/www/GROUPS/MUON/Persint/releases/opt;
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• Standalone machine
Download and install Qt from source 1. If you do not install it into a standard lo-
cation, add the path of the lib/pkgconfig subdirectory to your PKG CONFIG PATH
environment variable.

B.2.5 Mac OS X

Persint has been successfully installed under Mac OS X 10.5 and 10.6 using the following
environment.

• Mandatory dependencies

1. First install, if not already done, Apple’s Xcode tools from Mac OS X instal-
lation DVD or from Apple’s site

2. Download and install the MacPorts software distribution package

3. From a terminal, install everything Persint needs, using MacPorts (it could
take several hours):
sudo port selfupdate

sudo port -v install pkgconfig

sudo port -v install gcc45

sudo port -v install qt4-mac +debug

4. Ensure the chosen Fortran compiler and the Qt library will be found:
sudo ln -s /opt/local/bin/gfortran-mp-4.5 /opt/local/bin/gfortran

export PKG CONFIG PATH=/opt/local/lib/pkgconfig;

You might want to add PKG CONFIG PATH to your login script.

Depending on the installation method chosen, it may require you to also
install wget or subversion:
sudo port -dv install wget

sudo port -dv install subversion

• Optional additional dependencies

– Installing QtRoot on Mac OS X
To install QtRoot, you should download and run the INSTALL QTROOT.sh
shell script and follow the official instructions 2.

1. After installing the Qt library, set environment variables for QtRoot to
locate Qt:
export PKG CONFIG PATH=/opt/local/lib/pkgconfig;

export QTDIR=‘pkg-config --variable=prefix QtCore‘

2. Download and run the installation script as follows:
export QTROOT INSTALL DIR=${HOME}/qtRoot;
mkdir -p $QTROOT INSTALL DIR

cd $QTROOT INSTALL DIR

wget http://root.bnl.gov/QtRoot/INSTALL QTROOT.sh

chmod u+x INSTALL QTROOT.sh

. ./INSTALL QTROOT.sh

yes

yes

1http://qt.nokia.com/downloads
2http://root.bnl.gov/QtRoot/How2Install4Unix.html
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no

Note: using the above command lines, QtRoot will be installed in ${HOME}/qtRoot.
If you prefer another location, set QTROOT INSTALL DIR accordingly.

3. Set environment variables for Persint to locate QtRoot:
. ${QTROOT INSTALL DIR}/set environment.sh

You can then proceed with the default installation procedure (section B.1.1).

– Installing the Oracle Instant Client SDK and the SOCI database access
library

∗ Oracle Instant Client

sudo port install oracle-instantclient

export ORACLE LIBDIR=/opt/local/lib/oracle

export ORACLE INCDIR=/opt/local/lib/oracle/sdk/include

MacPorts may not be able to download the necessary files. In that case,
you shall :
1. Delete intermediate files created by the failed building process and

create a directory /opt/local/var/macports/distfiles/oracle-instantclient:
sudo port clean --all oracle-instantclient

sudo port selfupdate

sudo mkdir /opt/local/var/macports/distfiles/oracle-instantclient

2. Go to the Oracle download page, register, download the instantclient-basic-

10.2.0.4.0-macosx-x86.zip and instantclient-sdk-10.2.0.4.0-macosx-x86.zip

packages manually and place them into the newly created /opt/local/var/macports/

distfiles/oracle-instantclient directory.
3. Install the downloaded packages

sudo port install oracle-instantclient

export ORACLE LIBDIR=/opt/local/lib/oracle

export ORACLE INCDIR=/opt/local/lib/oracle/sdk/include

∗ SOCI

export SOCI HOME=/usr/share/soci/3.0.0

wget http://downloads.sourceforge.net/soci/soci-3.0.0.tar.gz

tar xvfz soci-3.0.0.tar.gz

rm -rf soci-3.0.0.tar.gz

mv soci-3.0.0 soci-3.0.0 src

cd soci-3.0.0 src/

./configure --include-prefix=${SOCI HOME}/include --lib-prefix=${SOCI HOME}/lib
--oracle-include=$ORACLE INCDIR --oracle-lib=$ORACLE LIBDIR

make

sudo make install

Note: using the above command lines, SOCI will be installed in /usr/share/soci/3.0.0.
Change this path if you want to install it somewhere else.

You can now download and install Persint following the default procedure (sec-
tion B.1.1).

• Updating with the latest Persint release
Assuming you have already installed all required libraries for an old Persint release,
you will need the following commands to setup your environment before installing
a new release:

export PKG CONFIG PATH=/opt/local/lib/pkgconfig;
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export ORACLE LIBDIR=/opt/local/lib/oracle

export ORACLE INCDIR=/opt/local/lib/oracle/sdk/include

export SOCI HOME=/usr/share/soci/3.0.0

cd soci-3.0.0 src/

export QTROOT INSTALL DIR=${HOME}/qtRoot;

. ${QTROOT INSTALL DIR}/set environment.sh

If you had chosen different installation paths, you shall adapt these commands
accordingly.

B.2.6 Cygwin

Install Persint on Cygwin 1.7.x 1 under Windows 7 2.

• Install or update Cygwin by running setup.exe.

– The following packages are required to download and build Persint:

wget make sed tar pkg-config gcc4-g++ gcc4-fortran qt4-devel-tools libQtCore4-devel

libQtGui4-devel libQtTest4-devel libQtNetwork4-devel

– The following packages are required to connect to an X server and start
Persint:

xorg-server xinit

• You can then download and install Persint following the default procedure (sec-
tion B.1.1).

• Connect to a Cygwin/X server by typing startxwin from the Cygwin shell:

startxwin

• Start Persint with the start persint.sh script.

./start persint.sh

1http://www.cygwin.com/
2Use the link setup.exe in the Twiki page: https://twiki.cern.ch/twiki/bin/view/Atlas/

Persint2Wiki
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C ATLAS coordinate system

Figure 109: ATLAS coordinate system.
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D Files used in Persint

D.1 File formats

Several types of files are encountered when using Persint. Most are specific to Persint,
except the “exported” files used for presentations and publications.
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File extension Description Default directory Comments

.p2vf Detector description file.
Persint-00-02-••
/example

Produced by Persint
with the Save view as
function of the File menu.
Retrieved with the
Open view function.
(Section 6.3, item 3)

.p2ts
Track parameter file for
displaying an event

Persint-00-02-••
/example

Produced with Save or
Save as, retrieved with
Open in the Set track
parameters window.
(Section 6.3, item 6)

.p2gm
Generated muon
parameter file

Persint-00-02-••
/example

Produced with the Save
action, retrieved with the
Open action in the
Generate muon tracks
window.
(Section 7.1, Figure 15)

amdb simrec.xxx
Detector geometry file
(”primary numbers”)

Persint-00-02-••
/amdcData/share

Loaded from the Volumes
tab of the Data manager
window. (Section 6.1.1,
item 1; figure 4a)

Bmagatlas.data Magnetic field file
Persint-00-02-••
/BFieldData/share

Loaded from the
Magnetic Field tab of the
Data manager window.
(Section 6.1.1, item 2;
figure 4b)

Out.MboyView yyy Reconstructed event file
Persint-00-02-••
/example

ASCII file produced by
ATHENA.
(Section 6.1.1, item 3,
figure 4c and
Section 6.1.2, item 2)

.png, .jpg, .bmp

.svg, .ps, .pdf
File containing the
Persint Main Display

User’s choice

Produced by Persint
with the Export function
of the File menu.
(Section 6.4)

.dat ASCII file User’s choice

Produced by the Export
function in the various
maps available in the
Tools menu
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D.2 Directories for Persint files

(a) Available geometry files in Persint/AmdcData/share. This window is prompted when clicking
Load in the Data manager window (Fig. 4a)

(b) Part of the file ”Persint-00-02-••/PersintData/AtlasNode AmdcFile MagFieldFile.txt”: Correspondence be-
tween geometry and magnetic field files

Figure 110: Details of some files used by Persint.

D.3 File description
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D.3.2 .p2ts

[simulation]

parameters\Gen_trk_at_IP\checked=0

parameters\Gen_trk_at_IP\value=0.1

parameters\Gen_trk_at_spectro\checked=1

parameters\Gen_trk_at_spectro\value=0.1

options\simul\value=1

[reconstruction]

parameters\Mboy_Seg\checked=1

parameters\Mboy_Seg\red=1

parameters\Mboy_Seg\green=0

parameters\Mboy_Seg\blue=0

parameters\Moore_Seg\checked=0

parameters\Moore_Seg\red=0

parameters\Moore_Seg\green=1

parameters\Moore_Seg\blue=0

parameters\ID_trk_at_IP\checked=0

.

parameters\Mboy_trk_at_IP\checked=0

.

parameters\Mboy_trk_at_spectro\blue=0

parameters\Staco_trk_at_IP\checked=0

.

parameters\MuTag_trk_at_IP\checked=0

.

parameters\Moore_trk_at_spectro\checked=0

.

parameters\MuID_Extra._trk\checked=0

.

parameters\MuIDcomb_trk_at_IP%20\checked=0

.

options\matter\value=1

options\width\value=1.71

[calorimeterCells]

parameters\barrel_presampler\checked=1

.

parameters\barrel_lar_em\checked=1

.

parameters\endcap_lar_em\checked=1

.

parameters\tile\checked=1

.

parameters\endcap_lar_hadr\checked=1

.

parameters\very_forward_lar\checked=1

.

parameters\endcap_presampler\checked=1

parameters\endcap_presampler\value=0.1

parameters\endcap_presampler\red=1

parameters\endcap_presampler\green=0.2

parameters\endcap_presampler\blue=0.2

options\envelop\value=0

[EgamaObjects]

parameters\Photons\checked=1

parameters\Photons\red=1

parameters\Photons\green=0.6

parameters\Photons\blue=0.2

parameters\Electrons\checked=1

parameters\Electrons\red=0.6

parameters\Electrons\green=0.6

parameters\Electrons\blue=0

[TRT]

parameters\bra\checked=0

parameters\bra\min=6

parameters\bra\max=50

options\braphi\value=32

parameters\brc\checked=0

parameters\brc\min=6

parameters\brc\max=50

options\brcphi\value=32

parameters\eca\checked=0

parameters\eca\min=6

parameters\eca\max=50

options\ecaphi\value=32

parameters\ecc\checked=0

parameters\ecc\min=6

parameters\ecc\max=50

options\eccphi\value=32

options\allenvelop\value=0

D.3.3 .p2gm

[Muons]
1\track=1.2, 90, 100, true, 0, 0, 0
1\color=@Variant(\0\0\0\x43\x1\xff\xff\xff\xff\0\0\0\0\0\0)
2\track=1.2, 0, 100, true, 0, 0, 0
2\color=@Variant(\0\0\0\x43\x1\xff\xff\0\0\0\0\xff\xff\0\0)
3\track=1.2, 0, 10, true, 0, 0, 0
3\color=@Variant(\0\0\0\x43\x1\xff\xff\0\0\xff\xff\0\0\0\0)
size=3
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D.3.4 amdb simrec.xxx

********************************************************************************

*

* NAME (16 Char.) of this AMDB_SIMREC data base (ATLAS Muon Layout version R) :

*

*

* ****************

* ****************

N R.03 01

* .Initial.Light.BML.S13.Patch

* BIS 1,2,4,5,6 without supports

* BML Old numbering

* EIL mv by 20m to avoid clashes in GeoModel/G4

* NO EEL, EES

* ****************

* ****************

*

* COMMENTS :

* Final Layout R

* R.03 01

* Huge corrections From Stefania Spagnolo on RPC orientation

* all corrections appear with comments "*"

* Update on RPC and cutouts

* -BMS 2 5, 6 , 7 (cutouts)

* -BOF

* -BOG

* -W RPC 7

* -add W DED 3

* Update XML part for Andrea converter

* -saddle

* -PP2

* -passerel/platforms

* -ECT_Cryo7SidTemp suppress composition replace by a rotation

* -many ";" + other correction in Patch Panel.

* R.02 03

* corrections From Andrea Dell’Acqua about ";" and TGCSupport

* Without symetry convention to build TGC support

* CSC position corrected

* R.02 02

* ID Patch Panels PP2 (not at the correct position)

* Muon Barrel Access Platforms

* Feet Struts

* Access Platform Sector 13

* MDT Big Wheel

* Calorimeter Saddle

* TGC support (not at the correct position)

* BOL Support

* Mobylette: Cyclomoteur

*

* R.02 01:

* Pierre-Franois

* new 1 BIM with HV <-> RO inverted

* new 6 BIR with HV <-> RO inverted + correction 75mm

* BIS8 bad position

* BML sector 13 add hole corresponding to elevator place

* 12345 -> 12367

* BOG bad position

* Stefania

* BMF1,BMF2,BMF3 LB2->LB1

* BOG1,BOG2,BOG4,BOG5 RPC size

* W PRC8, RPC17

* Florian

* BOS2,BOS3,BOF1->BOF8 1868->1853 (+3mm? should be checked)
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* BOS1 CRO est a -2656mm

* CRV est a 1050mm

* : Same Dead Matter as R.01.01

* initially based on q.02_test8

* R.01 01 BOG positions from ATLM____0034 Version AG (Layout R sector 12) based on Feet as installed

* EOL/EOS positions in Z according to Layout R Version AG

* BOG 6 RO/HV swapped from ATLM____0041 Version AG (Layout R sector 14)

* BOL sector 13 positions z+40 mm after elevator shaft according to Layout R Version AF

* AGDD-XML section : correction to JDSH_TUBEleng, JDSH_PLUGleng

* variable names follow DB conventions

* implementation of ECT Service Tower

* correction to EEL sector 9

* positions of stations located at Z<0 not mirrored following 30.035 wire pitch

* dz of BOG cutouts following 30.035 wire pitch

* BOL 3,6,7 swap dz of RPC and DED (stations not mirrored)

*

*

********************************************************************************

*

* VERSION NUMBER (Integer I5) of this AMDB_SIMREC data base (Default is 0)

*

* *****

* *****

V 7

* *****

* *****

*

*

********************************************************************************

*

* The lines which start with the character D correspond to the

* *****

*

* DEFINITION OF THE DIFFERENT STATIONS

*

* The station Typ It is formed of No different objects (or multi-layers).

* ******** ****

*

* Within a station, the relative postion of each object is given by

* dx , dy and dz , the local reference frame (x,y,z) being

* **** **** ****

* the same one as in V.Chaloupka Data Base.

*

*

* ---------------> Typ It : Identify the station type.

* |

* | -------------> No : Number of objects forming the station.

* | |

* | | And, for each object :

* | |

* | | -----------> dx, dy, dz : Relative position of the object.

* | | |

* | | | -------> Io : Object serial number in the station.

* | | | |

* | | | | -------> Tec : Type of technology used for the object.

* | | | | |

* | | | | | -------> Iw : Inner structure type index.

* | | | | | |

* | | | | | | --------> Isplit_x : Number of sections in x

* | | | | | | | for RPC’s (1 if missing).

* | | | | | | | ------> Isplit_y : Number of sections in y

* | | | | | | | | for RPC’s (1 if missing).

* | | | | | | | |

* | | | | | | | | ----> Ishape : Type of geometrical shape
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* | | | | | | | | | missing

* | | | | | | | | | or 0 --> trapezoidal (or rectangular)

* | | | | | | | | | 1 --> "T" shaped

* | | | | | | | | | 2 --> "Diamond" shape (CSC)

* | | | | | | | | | 3 --> rotated trapezoids (TGC)

* | | | | | | | | |

* | | | | | | | | | -----> Width_xS, Width_xL, Length_y,

* | | | | | | | | | | Excent., Dead1, Dead2 :

* | | | | | | | | | | Dimensions of the object

* | | | | | | | | | | (See figures).

* | | | | | | | | | |

* XXX-X X | | | | | | | |

*XXXXX--XXXXX--XXXXX X XXX X X X X XXXXXX--XXXXXX--XXXXXX--XXXXX--XXXXX--XXXXX

*XXXXX--XXXXX--XXXXX X XXX X X X X XXXXXX--XXXXXX--XXXXXX--XXXXX--XXXXX--XXXXX

* .....

*

*

*

********************************************************************************

*

* The lines which start with the character C correspond to the

* *****

*

* DEFINITION OF THE CUT-OUTs IN THE STATIONS

*

* The cut-out Icut in the station Typ It is formed of Nocut

* ****** ******** *******

* different sub-cuts in the various objects (or multi-layers) of

* this station.

*

*

* -------------> Typ It : Identify the station type.

* |

* | ------------> Icut : Cut-out index

* | |

* | | -------------> Nocut : Number of sub-cuts in the station.

* | | |

* | | | And, for each sub-cut :

* | | |

* | | | --------------> dx, dy : Relative position of the sub-cut.

* | | | |

* | | | | -------> Io : Serial number of the object in which

* | | | | | the sub-cut is made.

* | | | | |

* | | | | | -----> Width_xS, Width_xL, Length_y,

* | | | | | | Excent.

* | | | | | | Dimensions of the sub-cut

* | | | | | | (see figures).

* XXX-X X X | | |

*XXXXX--XXXXX X XXXXXX--XXXXXX--XXXXXX--XXXXX

*XXXXX--XXXXX X XXXXXX--XXXXXX--XXXXXX--XXXXX

* .....

*

*

*

*-- Definition of stations -----------------------------------------------------

* Typ I No

* s z t Io Tec i x y m W_xS W_xL L_y Ex D1 D2 D3

******* ******* *** ** ** ******** ******* *******

* ******* ** ** ** ******** ******** ******* *******

*

*

*-- Definition of BIL stations -------------------------------------------------

* Typ I No
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* dx dy dz Io Tec i x y s W_xS W_xL L_y Ex D1 D2

* ...

D BIL 1 7

0. 0. 0. 1 MDT 1 2671.5 2671.5 1081.261 0. 55. 0.

-1280. 0. 123.07 2 CHV 1 6.0 6.0 1081.261 0. 0. 0.

0. 0. 123.07 3 CMI 1 6.0 6.0 1081.261 0. 0. 0.

1280. 0. 123.07 4 CRO 1 6.0 6.0 1081.261 0. 0. 0.

0. 215. 170.57 5 LB 1 2620.0 2620.0 50. 0. 0. 0.

0. 815. 170.57 6 LB 1 2620.0 2620.0 50. 0. 0. 0.

0. 0. 293.07 7 MDT 2 2671.5 2671.5 1081.261 0. 55. 0.

D BIL 2 7

0. 0. 0. 1 MDT 1 2671.5 2671.5 901.051 0. 55. 0.

and so on ...

towards end of file ...

<mposPhi volume="rail1" ncopy="8" Phi0="-14.35" R_Z="10040;-6000" impliedRot="false" />

<mposPhi volume="rail2" ncopy="8" Phi0="14.35" R_Z="10040;-6000" impliedRot="false" />

</composition>

</section>

<section name = "Solenoid"

version = "1.1"

date = "22 11 1962"

author = "laurent"

top_volume = "Solenoid">

<!--

**************************************************************

*** Solenoid ****

**************************************************************

-->

<tubs name="tubs_hole" material="Azur" Rio_Z="1200;1300;5000" />

<composition name="Solenoid">

<posXYZ volume="tubs_hole" X_Y_Z=" 0 ; 0 ; 0" />

</composition>

</section>

<section name = "Eta0Services"

version = "1.1"

date = "22 11 1962"

author = "laurent"

top_volume = "Eta0Services">

<cons name="cons_angle" material="Orange" Rio1_Rio2_Z="4500;9000;4500;9000;300" profile="-14;28" />

<composition name="servicesAtZ0" >

<mposPhi volume="cons_angle" Phi0="45" ncopy="8" >

</mposPhi>

</composition>

</section>

</AGDD>

X -----------------------------------------------------------------------------------------

*

*

*

End
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D.3.5 Bmagatlas

B-3D-R.1 ATLM dtb => atlm01p
8 5.80 20500.00 20500.00

30 4 1.28 5.78 492.20 985.30 1241.00 137.90
1 4 1.25 4.30

32
122.46
498.57
825.04

1256.16
96.00
96.00
80 99 0.785398185

0.000000000 0.006000000 0.008500000 0.009000000 0.011000000 0.013900000
0.017238000 0.019000000 0.022000000 0.024070000 0.027379000 0.030670000
0.035531000 0.043423000 0.052974000 0.064359000 0.078351000 0.115947000
0.168554000 0.231067000 0.285960000 0.325066000 0.341732000 0.349282000
0.356406000 0.359997000 0.364267000 0.368445000 0.370000000 0.372000000
0.374908000 0.378033000 0.379500000 0.380000000 0.381000000 0.382000000
0.384113000 0.388406000 0.392699000 0.396685000 0.398699000 0.400670000
0.401699000 0.402500000 0.403760000 0.404000000 0.405199000 0.406800000
0.409937000 0.411699000 0.414699000 0.416769000 0.420078000 0.428230000
0.445673000 0.471050000 0.508646000 0.561253000 0.623766000 0.678659000
0.699990000 0.717765000 0.729584000 0.734431000 0.738464000 0.741981000
0.745518000 0.749105000 0.752696000 0.756966000 0.761144000 0.762699000
0.764699000 0.767607000 0.770732000 0.772699000 0.774699000 0.776812000
0.781105000 0.785398000

0.0000 38.0000 72.0000 100.0000 124.0000 145.0000
492.0000 516.0000 543.0000 566.0000 636.0000 723.0000
764.2500 791.7500 805.2619 812.8077 816.0000 818.0000

and so on ...
towards end of file ...

Cy;zJzEzNzOzv=yYP+2+1z+zwztzozmzjzhzf=xJ6=yZ1!2z8!2z7z6zaz5!2z7z6!2z7!4z6z5z6g.=
xrWy;=y6jyedPzu=z2m*2!5y;y,y:y,!2yZyXyWyV!2ySyQ!2yRySyVyXy.yL=-2Cy;zJzEzNzOzv=yY
P+2+1z+zwztzozmzjzhzf=xJb=yZ1!2z8z7z6z7zaz5!2z7z6!2z7!5z6z5g:=xrLy;=y;O*1=xQAzm=
z2ny;*1y;*1y;y:y;y,y:y,y.!2yY!2yV!2ySyQ!2yRySyVyXy.yL=-2Cy;zJzEzNzOzv=yYP+2+1z+z
wztzozmzjzhzf=xJi=yZ1z8z7z8z6z7zaz5!4z7z6z7z6z5!2z6z5h0=xrz*1=xYnystZzi=z2n*1y;*
1!3y;y:y,y:y,y.!2yY!2yV!2ySyQ!2yRySyVyXy.yL=-2Cy;zJzEzNzOzv=yYP+2+1z+zwztzozmzjz
hzf=xJq=yZ0z9!4z7zaz5z8z6!3z7!4z6z5z6h2Q0*3=xUezj=z2n*2!4y;y:y,y;!2y.!2yY!2yV!2y
SyQ!2yRySyVyXy.yL=-2Cy;zJzEzNzOzv=yYP+2+1z+zwztzozmzjzhzf=xJx=yZ0!2z8!3z7zaz6!2z
7z6!2z7z6z7z5!2z6z5h6=xqUz1NzyML1zm=z2oy;*1y;*1y;y:y;y.y;!2y.yZyXyWyU!2ySyQ!2yRy
SyVyXy.yL=-2Cy;zJzEzNzOzv=yYP+2+1z+zwztzozmzjzhzf=xJ)=yZ0!2z8!3z7zaz6!2z7z6z8z6z
7!3z6!2z5ha=xq-*1=y;O*1=xV)zq=z2o*1y;*1!3y;y:y,y:y,!2yZyXyWyUyTyRyQ!2yRySyVyXy.y
L=-2Cy;zJzEzNzOzv=yYP+2+1z+zwztzozmzjzhzf=xJD=yZ0!2z8!3z7zaz6!5z7!4z6z5z6hd=xqk*
1-xz3,Xzt=z2o*2!4y;y:y,y:y,!2yZyXyWyUyTyRyQ!2yRySyVyXy.yL=-2Cy;zJzEzNzOzv=yYP+2+
1z+zwztzozmzjzhzf=xJF=yZ0z8z7z8!2z7zaz6!5z7!5z6z5hfPQ*3=xVNzv=z2py;*1y;*1y;!2y:y
,y:y,!2yZyXyWyUyTyRyQ!2yRySyVyXy.yL
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D.3.6 Description of the Out.MboyView ASCII event file readable by PERSINT
Here is an example of an event file. The first word of each line is a keyword which has to start

on the first column : only the first 3 letters are mandatory, and usually case sensitive.

The first part of the file contains global parameters which are optionnal.

GEO geometry : if present, it should be the first line and contains info on the geometry to be

used, i.e. ATLAS-DC3-05.

RTpara integer allows to set the RT relations which will be used for MDT.

0 default, the RT will be explicitely given for each MDT of each event using the RS lines

which will be described later.

> 0 will use our "home-made" parametrization done on the first cosmic runs.

< 0 a constant value (equals to the abs of the given value, divided by 100) in cm will be used.

For nice displays, -120 is a good choice.

Then for each event,

NEW EVT eventNumber runNumber AmdcAthenaFlag CosmicFlag

AmdcAthenaFlag : hits are identified by the Amdc (0) or Athena identifiers (1 = default).

CosmicFlag : 0 if standard (collision) or 1 if cosmic

HIT numberMDThits numberRPChits numberTGChits number CSChits

MDT BIL i1 i2 i3 i4 i5 X Y Z DriftTime ADCcount Particle TDCcount digitID

i1 to i5 are the Athena idenfiers of the given tube/station

X Y Z are the positions of the middle of the tube. If unknow, put 0. 0. 0. and they will be

computed by Amdc.

RPC BML i1 i2 i3 i4 i5 i6 i7 i8 X Y Z Particle digitID time

i1 to i8 are the Athena identifiers of the given strip/station

X Y Z are the positions of the middle of the strip. If unknow, put 0. 0. 0. and they will be

computed by Amdc.

END EVT last line of the event.

In addition to the muon information, we can add calorimeter or tracking information in these

files. Starting with the calorimeter cells, the format is

CAL TYP radius eta phi layer Energy(MeV) deta dphi dr dx dy dz

TYP indicates the type of calorimeter. It must be one of the following 3 characters words :

PSB(PreSamplerBarrel), EMB(largEmBarrel), EME(largEmEndcap), TIL(tile), HEC(largHadronicEndcap), FCA(veryForwardEndcap)

or PSE(PreSamplerEndcap)

radius, eta and phi give the position of the center of the cell

deta, dphi, dr, dx, dy, dz give the size of the cell. The parameters used are (dx, dy, dz)

for FCA, (deta, dphi, dr) for PSB, EMB and TIL and (deta, dphi, dz) for EME, HEC and PSE.

The parameters not used may be arbitrary.

Example :

CAL EME 615.1562 -2.5600 0.2495 1 722.0 0.1000 0.0982 0.0000 0.0000 0.0000 224.1685 740294660

For Egamma Objects the format is :

CAL EgammaContainerLocation X Y Z Px Py Pz E eta phi Charge

electromagnetic objects are dumped if : //(isEM & 0x7FF)==0 means all cuts except TRT

X,Y,Z are the track intercept at the perigee, Px,Py,Pz are the gtrack momentum at the perigee

for neutral particles, X,Y,Z and Px,Py,Pz are set to 0

E, eta, Phi are the cluster energy, pseudo-rapidity and azimuth respectively

Example :

EGA egammaCollection 0.001 -0.035 -11.853 -50455.172 -792.320 -49976.254 73027.702 -0.882 -3.117 -1

For Trackparticle and Trk::Track Objects the format is :

TRK TrackParticle TrackParticleContainerLocation dummy X Y Z Px Py Pz Charge PDG_Code

the track representation is the perigee one

Examples

TRK McEventCollection TruthEvent dummy 0.009 0.006 23.258 -1400.825 2469.821 -6805.638 1 211

TRK CombinedMuon MboyESDMuonContainer dummy 2.488 -82.009 -591.075 -1125.241 -34.143 -7849.847 -1 0

TRK TrackRecord MuonEntryLayerFilter dummy -50.110 -52.002 -6740.000 -8.635 1.688 -125.547 -1 11

TRK CombinedMuon StacoCombinedMuonContainer dummy 0.000 0.001 84.526 31681.809 -12270.981 37905.569 1 0

TRK CombinedMuon MuidCombinedMuonContainer dummy 0.002 0.005 84.522 31454.320 -12184.459 37634.866 1 0

TRK CombinedMuon MuidExtrCombinedMuonContainer dummy -7.415 -19.176 94.293 32445.334 -12545.980 38727.635 1 0

TRK TrkTrack Tracks KalmanFitter 0.012 0.002 83.630 103.873 -670.289 -3445.807 1 0

TRK TrkTrack ConvertedMBoyMuonSpectroOnlyTracks Muonboy 4021.170 -1375.752 4822.313 28616.934 -9429.886 33776.897 1 0

TRK TrkTrack ConvertedMooreTracks MooreLegacyCnv 4133.017 -1699.972 5078.248 30054.322 -11982.251 36321.348 1 0

Description
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TRK McEventCollection TruthEvent are the generated tracks. They are drawn inside the tracker (except for muons).

TRK TrackRecord MuonEntryLayerFilter are the generated tracks at the spectrometer entrance.

They are drawn starting from the surface defining this spectrometer entrance.

TRK TrkTrack ConvertedMBoyMuonSpectroOnlyTracks are the Muonboy tracks, drawn inside the spectro.

TRK CombinedMuon MboyESDMuonContainer are the Muonboy tracks, back-propagated to the interaction point.

TRK TrkTrack Tracks are the tracks from the Inner Detector.

TRK CombinedMuon StacoCombinedMuonContainer describe the Staco tracks, i.e. combination of InDet and Spectro tracks.

For Segment Objects the format is :

SEG MuonSegment TrkSegmentCollectionLocation X Y Z Dx Dy Dz Chi2

X,Y,Z are the segment position (global frame)

Dx,Dy,Dz the segment direction

Chi2 the segment Chi-squared

Example :

SEG MuonSegment ConvertedMBoySegments -7271.419 -5869.373 -14294.539 -0.114541 -0.096927 -0.988679 8.2018
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D.3.7 Out.MboyView Zmumu4023
GEO ATLAS-GEO-02-01-00

NEW EVT 4023 5145 1 0

HIT 44 36 0 0 0

MDT BIL 2 3 1 1 1 0.000 4770.927 1280.035 0.000 101 6 1737 0 1

MDT BIL 2 3 1 2 2 0.000 4796.939 1295.052 0.000 88 6 1224 1 1

MDT BIL 2 3 1 3 2 0.000 4822.950 1310.070 0.000 161 6 1098 2 1

MDT BIL 2 3 1 4 3 0.000 4848.961 1325.087 0.000 90 6 1385 3 1

MDT BIL 2 3 2 1 5 0.000 5048.997 1385.157 0.000 145 6 1539 4 1

MDT BIL 2 3 2 2 4 0.000 5075.009 1370.140 0.000 85 6 1552 5 1

MDT BIL 2 3 2 3 5 0.000 5101.020 1385.157 0.000 116 6 1162 6 1

MDT BIL 2 3 2 4 5 0.000 5127.031 1400.175 0.000 147 6 1152 7 1

MDT BIL 2 7 1 1 7 -0.000 -4770.927 1460.245 0.000 83 6 1571 8 1

MDT BIL 2 7 1 2 7 -0.000 -4796.939 1445.227 0.000 88 6 1574 9 1

MDT BIL 2 7 1 3 7 -0.000 -4822.950 1460.245 0.000 107 6 1188 10 1

MDT BIL 2 7 1 4 8 -0.000 -4848.961 1475.262 0.000 90 6 1112 11 1

MDT BIL 2 7 2 1 10 -0.000 -5048.997 1535.332 0.000 108 6 1098 12 1

MDT BIL 2 7 2 2 10 -0.000 -5075.009 1550.350 0.000 146 6 1205 13 1

MDT BIL 2 7 2 3 11 -0.000 -5101.020 1565.367 0.000 83 6 1613 14 1

MDT BIL 2 7 2 4 10 -0.000 -5127.031 1550.350 0.000 80 6 1532 15 1

MDT BIS -7 8 1 3 6 4176.601 -1730.005 -6070.210 0.000 129 6 1326 16 1

MDT BIS -7 8 2 4 23 4306.481 -1783.803 -6580.805 0.000 94 6 1958 17 1

MDT BML 2 3 1 1 3 0.000 6913.457 1925.087 0.000 103 6 1179 18 1

MDT BML 2 3 1 2 3 0.000 6939.469 1940.105 0.000 133 6 1134 19 1

MDT BML 2 3 1 3 4 0.000 6965.480 1955.122 0.000 83 6 1426 20 1

MDT BML 2 3 2 1 7 0.000 7312.517 2045.227 0.000 106 6 1302 21 1

MDT BML 2 3 2 2 7 0.000 7338.529 2060.245 0.000 66 6 1096 22 1

MDT BML 2 3 2 3 8 0.000 7364.540 2075.262 0.000 104 6 1250 23 1

MDT BML 2 7 1 1 10 -0.000 -6913.457 2135.332 0.000 94 6 1504 24 1

MDT BML 2 7 1 2 9 -0.000 -6939.469 2120.315 0.000 101 6 1653 25 1

MDT BML 2 7 1 3 10 -0.000 -6965.480 2135.332 0.000 120 6 1220 26 1

MDT BML 2 7 2 1 14 -0.000 -7312.517 2255.472 0.000 116 6 1237 27 1

MDT BML 2 7 2 2 14 -0.000 -7338.529 2270.490 0.000 83 6 1683 28 1

MDT BML 2 7 2 3 14 -0.000 -7364.540 2255.472 0.000 116 6 1475 29 1

MDT BOL 2 3 1 1 12 0.000 9274.457 2675.402 0.000 98 6 1084 30 1

MDT BOL 2 3 1 2 12 0.000 9300.469 2690.420 0.000 110 6 1126 31 1

MDT BOL 2 3 1 3 13 0.000 9326.480 2705.437 0.000 64 6 1700 32 1

MDT BOL 2 3 2 1 16 0.000 9673.517 2795.542 0.000 99 6 1418 33 1

MDT BOL 2 3 2 2 16 0.000 9699.529 2810.560 0.000 97 6 1152 34 1

MDT BOL 2 3 2 3 17 0.000 9725.540 2825.577 0.000 106 6 1178 35 1

MDT BOL 2 7 1 1 18 -0.000 -9274.457 2855.612 0.000 127 6 1185 36 1

MDT BOL 2 7 1 2 18 -0.000 -9300.469 2870.630 0.000 126 6 1148 37 1

MDT BOL 2 7 1 3 19 -0.000 -9326.480 2885.647 0.000 96 6 1441 38 1

MDT BOL 2 7 2 1 22 -0.000 -9673.517 2975.752 0.000 107 6 1323 39 1

MDT BOL 2 7 2 2 22 -0.000 -9699.529 2990.770 0.000 75 6 1096 40 1

MDT BOL 2 7 2 3 23 -0.000 -9725.540 3005.787 0.000 111 6 1257 41 1

MDT BOL 4 2 2 2 4 6858.603 6858.603 6330.140 0.000 98 6 1650 42 1

MDT BOL 4 6 1 1 23 -6558.031 -6558.031 6885.787 0.000 95 6 1961 43 1

RPC BML 2 3 1 1 2 1 0 2 -860.000 6808.790 1900.750 6 44 31.250

RPC BML 2 3 1 1 2 1 0 3 -860.000 6808.790 1927.250 6 45 31.250

RPC BML 2 3 1 1 2 1 0 1 -860.000 6808.790 1874.250 6 46 34.375

RPC BML 2 3 1 1 2 2 0 2 -860.000 6831.090 1900.750 6 47 31.250

RPC BML 2 3 1 1 2 2 0 3 -860.000 6831.090 1927.250 6 48 31.250

RPC BML 2 3 1 1 2 1 1 41 -1086.100 6808.790 2285.000 6 49 25.000

RPC BML 2 3 1 1 2 1 1 40 -1059.500 6808.790 2285.000 6 50 31.250

RPC BML 2 3 1 1 2 2 1 41 -1086.100 6831.090 2285.000 6 51 28.125

RPC BML 2 3 2 1 2 1 0 10 -860.000 7486.900 2112.750 6 52 31.250

RPC BML 2 3 2 1 2 2 0 10 -860.000 7509.200 2112.750 6 53 31.250

RPC BML 2 3 2 1 2 1 1 44 -1165.900 7486.900 2285.000 6 54 34.375

RPC BML 2 3 2 1 2 1 1 45 -1192.500 7486.900 2285.000 6 55 34.375

RPC BML 2 3 2 1 2 2 1 45 -1192.500 7509.200 2285.000 6 56 34.375

RPC BML 2 7 1 1 2 1 0 9 860.000 -6808.790 2086.250 6 57 34.375

RPC BML 2 7 1 1 2 2 0 10 860.000 -6831.090 2112.750 6 58 31.250

RPC BML 2 7 1 1 2 2 0 9 860.000 -6831.090 2086.250 6 59 34.375

RPC BML 2 7 1 1 2 1 1 12 314.700 -6808.790 2285.000 6 60 28.125

RPC BML 2 7 1 1 2 1 1 13 341.300 -6808.790 2285.000 6 61 31.250

RPC BML 2 7 1 1 2 2 1 13 341.300 -6831.090 2285.000 6 62 28.125

RPC BML 2 7 2 1 2 1 0 17 860.000 -7486.900 2298.250 6 63 34.375

RPC BML 2 7 2 1 2 2 0 17 860.000 -7509.200 2298.250 6 64 37.500

RPC BML 2 7 2 1 2 1 1 14 367.900 -7486.900 2285.000 6 65 31.250

RPC BML 2 7 2 1 2 2 1 14 367.900 -7509.200 2285.000 6 66 34.375

RPC BOL 2 3 1 1 2 1 0 15 -1212.500 9835.400 2834.000 6 67 40.625

RPC BOL 2 3 1 1 2 1 0 16 -1212.500 9835.400 2868.000 6 68 43.750

RPC BOL 2 3 1 1 2 1 0 17 -1212.500 9835.400 2902.000 6 69 43.750

RPC BOL 2 3 1 1 2 2 0 16 -1212.500 9857.700 2868.000 6 70 43.750

RPC BOL 2 3 1 1 2 1 1 51 -1528.550 9835.400 2885.000 6 71 40.625

RPC BOL 2 3 1 1 2 1 1 52 -1558.650 9835.400 2885.000 6 72 40.625

RPC BOL 2 3 1 1 2 1 1 54 -1618.850 9835.400 2885.000 6 73 40.625

RPC BOL 2 3 1 1 2 1 1 53 -1588.750 9835.400 2885.000 6 74 43.750

RPC BOL 2 3 1 1 2 2 1 52 -1558.650 9857.700 2885.000 6 75 40.625

RPC BOL 2 7 1 1 2 1 0 23 1212.500 -9835.400 3023.150 6 76 50.000

RPC BOL 2 7 1 1 2 2 0 24 1212.500 -9857.700 3053.450 6 77 50.000

RPC BOL 2 7 1 1 2 1 1 16 475.050 -9835.400 2705.000 6 78 37.500

RPC BOL 2 7 1 1 2 2 1 16 475.050 -9857.700 2705.000 6 79 40.625

RS3 0 -1308.750 4770.927 1280.035 1.0000000 0.0000000 0.0000000 12 222.625 12.860 12.854 12.846 12.838 12.830 12.822 12.814 12.804 12.793 12.782 12.773 12.762 12.750

RS3 1 -1308.750 4796.939 1295.052 1.0000000 0.0000000 0.0000000 12 222.625 5.662 5.646 5.628 5.608 5.587 5.560 5.531 5.505 5.484 5.461 5.426 5.391 5.358

RS3 2 -1308.750 4822.950 1310.070 1.0000000 0.0000000 0.0000000 12 222.625 1.356 1.324 1.289 1.261 1.239 1.216 1.179 1.137 1.100 1.072 1.038 0.978 0.920

RS3 3 -1308.750 4848.961 1325.087 1.0000000 0.0000000 0.0000000 12 222.625 8.765 8.752 8.740 8.729 8.718 8.705 8.689 8.672 8.655 8.637 8.620 8.604 8.589

and so on ...

RS3 43 -4822.968 -8293.094 6885.787 -0.7071068 0.7071068 0.0000000 21 236.262 14.548 14.546 14.543 14.541 14.538 14.535 14.532 14.525 14.516 14.509 14.504 14.499 14.492 14.485 14.478 14.471 14.463 14.454 14.448 14.445 14.438 14.425

TRK TrackRecord MuonEntryLayerFilter dummy 26.231 31.511 -5169.224 0.120 -7.474 -239.587 1 -11

TRK TrackRecord MuonEntryLayerFilter dummy 34.158 -22.677 4018.539 -37.150 33.002 325.454 1 211

TRK TrackRecord MuonEntryLayerFilter dummy 303.879 1107.051 -881.413 275.440 -195.088 -130.474 1 211

TRK TrackRecord MuonEntryLayerFilter dummy 26.442 31.334 3931.646 -265.210 -166.037 1465.477 -1 -211

TRK TrackRecord MuonEntryLayerFilter dummy -19.992 77.941 -6750.000 18.730 99.074 -7258.469 -1 -211

TRK TrackRecord MuonEntryLayerFilter dummy -0.584 40.996 -4986.499 -3.045 -9.014 -114.564 1 -11
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TRK TrackRecord MuonEntryLayerFilter dummy 19.337 36.153 -4880.334 11.948 -29.038 -142.377 1 -11

TRK TrackRecord MuonEntryLayerFilter dummy -3.994 40.805 -5043.736 -13.777 -7.566 -159.787 -1 11

TRK TrackRecord MuonEntryLayerFilter dummy 5.694 40.603 -5154.146 -2.102 -44.098 -604.135 1 -11

TRK TrackRecord MuonEntryLayerFilter dummy 0.281 40.999 -5648.321 0.957 -13.118 -193.964 -1 11

TRK TrackRecord MuonEntryLayerFilter dummy 688.370 -918.723 2261.243 -229.182 -66.157 376.339 1 211

TRK TrackRecord MuonEntryLayerFilter dummy 4.389 54.630 6750.000 -7.909 485.134 63057.680 -1 -211

TRK TrackRecord MuonEntryLayerFilter dummy 40.997 0.510 3480.941 -305.727 -539.746 1183.440 1 2212

TRK TrackRecord MuonEntryLayerFilter dummy -10.345 -51.670 -6750.000 -192.807 -783.343 -95296.601 -1 -211

TRK TrackRecord MuonEntryLayerFilter dummy -2.909 40.897 -4784.081 210.335 -339.444 -2224.941 1 2212

TRK TrackRecord MuonEntryLayerFilter dummy -25.355 61.174 -6750.000 -600.697 1353.510 -154378.164 1 211

TRK TrackRecord MuonEntryLayerFilter dummy -12.254 -65.734 -6750.000 -207.946 -1240.695 -121680.794 1 211

TRK TrackRecord MuonEntryLayerFilter dummy -677.366 4196.687 1128.050 -3174.049 20625.379 5930.249 1 -13

TRK TrackRecord MuonEntryLayerFilter dummy 215.236 -4245.547 1281.801 3628.730 -75960.679 24125.117 -1 13

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 1149.462 -2204.148 216907.812 0 21

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -1054.058 -829.331 -310323.094 0 21

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -20725.680 -55372.098 56198.594 0 -4

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 40281.672 -1251.868 -47630.750 0 4

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -1087.246 -55982.418 32977.281 0 23

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 0.000 0.000 0.000 3688.245 -81230.836 25813.461 -1 13

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 0.000 0.000 0.000 -4775.492 25248.418 7163.820 1 -13

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -1087.246 -55982.418 32977.281 0 23

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 0.000 0.000 0.000 3595.597 -79488.586 25240.912 -1 13

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 0.000 0.000 0.000 -4775.216 25246.961 7163.415 1 -13

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 39219.113 56356.379 60462.516 0 4

TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -934.032 2752.398 10946.362 0 21

and so on ...

CAL TIL 1646.0000 1.5104 -1.0308 0 113.0 0.2000 0.0982 181.0000 0.0000 0.0000 8.0000 1284329264

CAL TIL 1646.0000 1.5104 -0.8345 0 225.2 0.2000 0.0982 181.0000 0.0000 0.0000 8.0000 1284362032

CAL TIL 2066.0000 1.3098 -0.7363 0 611.2 0.2000 0.0982 239.0000 0.0000 0.0000 8.0000 1284377904

CAL TIL 1646.0000 1.5104 -0.3436 0 115.2 0.2000 0.0982 181.0000 0.0000 0.0000 8.0000 1284443952

TRK CombinedMuon MboyESDMuonContainer dummy -15.153 -2.748 -73.463 -4127.595 22763.613 6537.681 1 0

TRK CombinedMuon MboyESDMuonContainer dummy 5.662 0.232 -69.260 3476.724 -84711.070 26957.698 -1 0

TRK CombinedMuon StacoCombinedMuonContainer dummy 1.595 0.072 -66.480 3823.643 -84175.569 26698.228 -1 0

TRK CombinedMuon StacoCombinedMuonContainer dummy 1.922 0.364 -67.822 -4684.434 24730.417 7015.255 1 0

TRK CombinedMuon MuidCombinedMuonContainer dummy 1.596 0.072 -66.480 3795.742 -83572.482 26507.004 -1 0

TRK CombinedMuon MuidCombinedMuonContainer dummy 1.919 0.363 -67.827 -4789.944 25295.987 7176.314 1 0

TRK CombinedMuon MuGirlCombinedMuonContainer dummy 1.919 0.363 -67.804 -4780.355 25244.324 7156.335 1 0

TRK CombinedMuon MuGirlCombinedMuonContainer dummy 1.597 0.073 -66.453 3780.566 -83257.069 26385.272 -1 0

TRK CombinedMuon MuGirlCombinedMuonContainer dummy 1.597 0.073 -66.453 3780.566 -83257.069 26385.272 -1 0

TRK CombinedMuon MuidExtrCombinedMuonContainer dummy 14.491 0.578 -69.406 3423.688 -85821.615 27312.401 -1 0

TRK CombinedMuon MuidExtrCombinedMuonContainer dummy 36.455 6.768 -71.602 -4663.056 25116.948 7215.593 1 0

TRK TrkTrack Tracks GlobalChi2Fitter -0.362 2.231 -75.922 -1906.348 -309.684 -8717.668 -1 0

TRK TrkTrack Tracks GlobalChi2Fitter 0.729 -0.213 -65.348 -170.245 -583.032 381.741 -1 0

TRK TrkTrack Tracks GlobalChi2Fitter -0.245 2.386 -74.900 -7773.899 -799.400 -34786.180 1 0

TRK TrkTrack Tracks GlobalChi2Fitter -0.925 0.690 -56.395 -326.254 -437.493 1835.077 -1 0

TRK TrkTrack Tracks GlobalChi2Fitter 0.433 -0.023 -64.817 -35.997 -690.686 1287.463 -1 0

TRK TrkTrack Tracks GlobalChi2Fitter -0.170 0.118 -69.815 16145.576 23291.786 24952.900 1 0

and so on ...

towards end of file ...

TRK TrkTrack Tracks GlobalChi2Fitter -11.839 11.872 -541.449 545.862 544.334 -492.060 -1 0

TRK TrkTrack ConvertedMBoyMuonSpectroOnlyTracks Muonboy -663.671 4197.861 1128.441 -3158.298 20126.521 5786.598 1 0

TRK TrkTrack ConvertedMBoyMuonSpectroOnlyTracks Muonboy 210.489 -4244.784 1281.564 3915.525 -81367.942 25839.576 -1 0

VTX VxPrimaryCandidate 1.4989 2.5093 -67.2314

SEG MuonSegment ConvertedMBoySegments -1129.503 7138.999 1999.174 -0.148683 0.944727 0.292205 1.3543

SEG MuonSegment ConvertedMBoySegments 350.289 -7138.999 2195.211 0.046998 -0.953258 0.298479 0.3012

SEG MuonSegment ConvertedMBoySegments -1506.562 9499.999 2748.712 -0.149175 0.940661 0.304800 2.2791

SEG MuonSegment ConvertedMBoySegments 458.330 -9499.999 2929.664 0.046037 -0.954235 0.295492 2.6723

SEG MuonSegment ConvertedMBoySegments -1230.750 4948.979 1345.019 -0.232330 0.934226 0.270637 0.4230

SEG MuonSegment ConvertedMBoySegments 615.375 -4948.979 1505.046 0.117707 -0.946624 0.300082 0.3672

END EVT
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E Menu items

E.1 File menu

(a) Linux style (b) Mac OS style

Item name Action

Data manager Load various files:
Volumes, Events, Magnetic field and others

Open view . . . Open a Persint .p2vf file for display

Save view as . . . Save view as a Persint .p2vf file

Export view . . . Export (save) view as a local file (.png, .jpg, .bmp, .svg)

Save special. . . To compare geometries (sections 6.4, and 9.3)

Print Print current view

Download . . . - Download geometry files from Oracle data base at CERN
- Download data from Trac server (Not yet available)
- Download additional field maps from:
https://atlas.web.cern.ch/Atlas/GROUPS/MUON/magfield/Fieldmap

Quit Quit Persint (for Linux only) 1

1In Mac OS, use “Quit” in the persint menu (section E.8).



124 E MENU ITEMS

E.2 Image menu

(a) Linux style (b) Mac OS style

Item name Action

Clear Several options:
- Clear view (completely); one can also use the “Brush”
- Partial clear of AMDB or AGDD volumes
- Clear event: clears the event hits and associated chambers
- Clear labels: clears all labels in the display.
- Clear captions: clears all captions in the display.
- Clear pictures (logos): clears all pictures in the display.

Compute Make the calculation to display the newly defined view

Previous view Display the view defined by the previous “Compute” action.
Up to 10 backward steps are possible

Logo 1 Display or hide the Persint logo at the bottom left of the
display.

Background color 1 Choose the background color of the main display window

Specific edge color 1 Define the color of volume edges in the display

Wire mode Switch the Wire mode on/off for all the displayed volumes

Anti-aliasing Provide smooth volume edges

Axes Display the ATLAS coordinate system in various styles

Projection Display 3D views or 2D projections; makes axes inversion

1Not present as an icon in the default tool bar.
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E.3 Navigation menu

(a) Linux style (d) Mac OS style
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# Item name Action

1 Default mode
All purpose function to perform Rotation, Transla-
tion, Zoom-in/out, Zoom on custom area (see sec-
tion 8.2)

2 Translation Translate the view in any direction

3 Zoom-in 1 Zoom-in by moving the viewing point forward, to en-
large the view

4 Zoom-out 1 Zoom-out by moving the viewing point backwards, to
reduce the view

5 Initial zoom Retrieve the original viewing parameters

6 Zoom on custom area Define the region to be enlarged

7 Rotation 1 Rotate view around center point of display

8 Set center Center view on a point chosen with the cursor

9 Volume information Open the Modify volume window to choose volume
parameters: Color, Hide, Translation, Rotation

10 Selection mode 2 Select a series of volumes to be hidden

11 Navigation scale 2 Set the amplitude of the following navigation actions:
Rotation, Zoom-in/out

12 Focal length 2 Set the focal length of the viewing.

13 Reset focal length 2 Reset focal length to nominal value (35 mm)

14 Isometric view 2 Set/reset parameters for isometric viewing (infinite fo-
cal length).

1The amplitude of these actions is controlled by the displacement of the cursor in the Navigation scale
gauge

2These five items of the Navigation tool bar are NOT in the Menu.
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E.4 Volumes menu

(a) Linux style (b) Mac OS style

Displaced volumes window

Figure 111: Volumes can be displaced in the X, Y, Z directions and/or rotated.
The volumes shown in this window are ”hidden” or Moved to infinity : X = Y = Z =
19999.00 cm. (section 9.2)

Create volume window

The Create volume function is used to draw many types of volumes. The func-
tion is embedded in Persint and is used, for example, to display the dead matter
structures of ATLAS. It uses the AGDD XML description.
The xml structure of the AGDD file is given below in E.4.1, and the subroutine
used to create volumes is shown in E.4.2.

Figure 112: With the Create volume function it is possible
to draw one volume at a time with chosen dimensions and
color. The available shapes are:
− Box (width, length, height)
− Sphere (diameter, # of facets)
− Cone (diameter, height, # of facets)
− Frame (Diameter, length, height, thickness)
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Very clear examples of the various AGDD XML volumes can be found in [9], where
the ATHENA package AGDD2Geo is presented in connexion with the AGDD XML
structure.
A summary list of the AGDD volume types described in [9] is given below:

• Cube

• Tube

• Pyramid

• Cylinder

• Chain

• Polygons

• Combined volumes

• Merged volumes

• Subtracted volumes

• Extruded volumes

Item name Action

Clashes Show/Hide intersections of clashing volumes (for debugging
geometry)

Displaced volumes Show and edit list of displaced volumes (“Move to infinity”)

Create volumes Draw many types of volumes, e.g. dead matter, using the
AGDD XML description
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E.5 Events menu

(a) Linux style (b) Mac OS style
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Item name Action

Reload event 1 Load current event again

Next event Display next event of the active Event file

Start autoscan Display successive events in regular time intervals

Autoscan speed
Set the time interval between two consecutive event displays (1, 2,
5, 10, 20, or 30 seconds)

Store visualization properties
Store viewing parameters from one event to the next, when scanning
an event file

Chambers, strips and tubes 3 Display/Hide chambers, trips and tubes ”in one stroke”

Chambers 3 Display/Hide the entire chamber

Strips 3 Display/Hide RPC strips

Tubes 3 Display/Hide MDT tubes

Envelopes of tubes3 Display/Hide the tube envelopes

Hit calorimeter cells Display the hit cells of the calorimeters

Select Sectors. . . Select sectors for displaying chambers with hits in an event

Simulation tracks Display simulation tracks

Athena reconstruction Display tracks reconstructed by ATHENA

Muonboy interactive reconstruction
Use the embedded MuonBoy program to ineractively reconstruct
segments and tracks

Display vertex candidates Display primary vertex candidates of the current event

Download A lines 3 Download A-lines for each event from the ATLAS data base

Generate muon tracks
Generate muon tracks at the IP. The vertex position, ϕ, η, and Pt

can be chosen (and the color !)

Set track parameters
Open window (Fig. 6) where the objects to be displayed are chosen
and their parameters set

Minimum number of hits. . . Minimum # of hits required for a MDT chamber to be displayed

Use all dead matter
Choose to use ALL dead matter or only DISPLAYED dead matter
when computing track momentum with energy loss

1Active only if an event is displayed.
2Active only if an event file is loaded.
3Not present as an icon in the default tool bar.
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E.5.1 Set track parameters window

(a) Selections for Reconstruction (b) Selections for Calorimeter cells

(c) Selections for Simulation (d) Selections for E/G objects

(e) Selections specific to the TRT detector

Figure 113: The two panes in the Set track parameters window (Mac OS style).
Thresholds can be set for track momentum and calorimeter cell energy (both in GeV).
The selections in the TRT pane concern cuts on timing.



140 E MENU ITEMS

Parameter Description

Reconstruction

Muonboy segments Choose color

Moore segments Choose color

ID tracks at IP Pt threshold in GeV/c; choose color

Muonboy tracks at IP Pt threshold in GeV/c; choose color

Muonboy tracks at Spectrom-
eter

Pt threshold in GeV/c; choose color

Staco tracks at IP Pt threshold in GeV/c; choose color

MuTag tracks at IP Pt threshold in GeV/c; choose color

Moore tracks at Spectrometer Pt threshold in GeV/c; choose color

MuID extra tracks Pt threshold in GeV/c; choose color

MuID Combined tracks at IP Pt threshold in GeV/c; choose color

Maximum |d0| Maximum allowed track impact parameter (x,y plane)

Maximum |z0| Maximum allowed track impact parameter (z direction)

Track shape Choose shape of the track: Ribbon, Crossed ribbons, or Cylinder

Draw scattering boxes Scattering centers used in the reconstruction are shown (or hidden)

Track width Can be adjusted with ruler or spinbox

Segment width Can be adjusted with ruler or spinbox

Simulation

Generated tracks at IP Pt threshold in GeV/c

Generated tracks at Spectro Pt threshold in GeV/c

Displayed tracks Only muons; only charged; only neutrals; all tracks

Calorimeter cells

General threshold General threshold on E or ET for all calorimeter cells, in GeV/c2

LAr e.m. barrel presampler E or ET threshold in GeV/c2; choose color

LAr e.m. barrel E or ET threshold in tower (GeV/c2); choose color

LAr e.m. end-cap (EMEC) E or ET threshold in GeV/c2; choose color

Tile calorimeter E or ET threshold in GeV/c2; choose color

LAr hadronic end-cap (HEC) E or ET threshold in GeV/c2; choose color

LAr forward (FCAL) E or ET threshold in GeV/c2; choose color

Cut-off criterion Choose E or ET threshold

Draw cell envelope

E/G objects

Photons Display or hide photons

Electrons Display or hide electrons
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Parameter Description

TRT

TRT barrel A and C - Cuts on ”time over threshold”
- Choose Phi sectors (1-32)

TRT End-Cap A and C - Cuts on ”time over threshold”
- Choose Phi sectors (1-32)

Draw tube envelope Draw or hide

Action box What it does

�� ��Restore defaults Sets parameters back to default values�� ��Open
Open any .p2ts file containing saved parameters from
previous work�� ��Save as
Save parameter file with the name of your choice to any
directory�� ��Save
Save modified parameter file with the same name to the
same directory�� ��Cancel Cancel operation and leave parameter file unchanged

�� ��OK
Validates parameter file; to take effect, this validation
must be followed by the Compute action; the file is not
automatically saved
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E.6 Tools menu

There is no default tool bar for this menu.

(a) Linux style (b) Mac OS style

Item name Action

Edit color palette Opens the Edit color table window, where the colors as well
as the color density can be chosen

Animation . . . Opens the Generating animation window, where parame-
ters which control the animation can be chosen

Preferences . . . 1

Set preferences for saving track parameters, magnetic field
display, show warnings for reconstruction errors, disable
Log console, as well as network parameters for access to
CERN data bases

Histogram . . . 2
There are 6 types of histograms/maps available:
calorimeter cells, vertex (d0), magnetic field, field
integral, X0, expected # of stations

Edit color palette and Animation windows:

(a) Edit color palette (b) Generating animation

Figure 114: Layout of the windows for ”Editing the color palette” (a), and
”Generating animation” (b).

1In the case of a Mac OS environment, the Preferences function is found in the Persint menu.
2With Linux, Create histogram is also found in the Tools menu, provided QtRoot is installed.
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Preferences windows:

(a) ”General” Preferences

(b) ”Network” Preferences

Figure 115: The setting of Preferences (to be found in the Persint menu for the
Mac OS environement):
a) General for saving track settings with view, update/no-update of view, showing
magnetic field in volume information boxes, disabling/enabling Log console and warning
messages for reconstruction errors
b) Network for choosing a ”proxy” when downloading from a CERN server (e.g. align-
ment constants)
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E.7 Window menu

There is no default tool bar for this menu.

(a) Linux style (b) Mac OS style

Item name Action

Reset window layout Set the default layout of the Persint display

Dimensions Set image canvas size

Full-screen Makes the Main display full-screen; as a shortcut,
type F (lower case) to enter or quit full-screen mode

1 View

AMDB Enable the AMDB Selector window

AMDB (v1) Enable a previous version of the AGDD Selector
window

AGDD Enable the AGDD Selector window

X0 Enable the X0 window (amount of material)

Log Enable the Log window
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E.8 Help menu

There is no default tool bar for this menu.

(a) Linux style (b) Mac OS style

Item name Action

Linux style

User Manual Opens the Persint User Manual in your web browser

About Persint Open information window about Persint; the version
number is found here

About Qt Open information window about Qt

Mac OS style

Search Search for commonly used functions

User Manual Opens the Persint User Manual in your web browser
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E.9 persint menu (Mac OS only)

There is no default tool bar for this menu.

(a) Mac OS style

Item name Action

About Persint Open information window about Persint; the version
number is found here

About Qt Open information window about Qt

Preferences . . . 1

Set preferences for saving track parameters, magnetic
field display, show warnings for reconstruction errors, dis-
able Log console, as well as network parameters for access
to CERN data bases

. . .

Quit Persint 1

1In the Linux environment, Preferences is found in the Tools menu (see section E.6 where the two
Preferences windows are shown), and Quit is found in the File menu (section E.1)
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E.10 Warning messages

On various occasions, Persint encounters an error which is reported in a message like
those shown below.
Note that for these messages to appear, the Show errors box should be checked in the
Preferences window (see figure 115a, page 143).

(a) Failed download of alignment corrections

(b) Event too big for Muonboy reconstruction with standard settings
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F Right-click

Figure 116: Special menus available through Right-click on various areas of the Persint
display

.

The special menu which appears depends on the location of the cursor when right-clicking.
In the case of a reconstructed track, there is a menu item called Edit track illustrated
in figure 117.
Rmax and Zmax (both in cm) define the cylinder, centered on the IP, which contains the
track.

Figure 117: Window which opens when clicking on Edit track in the special menu
obtained with a right-click on a track

.
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G Producing Event files for Persint in ATHENA

ASCII Event files for input to Persint (Out.MboyView xxx) are produced in ATHENA
from raw data. These files contain all coded information needed to display the recon-
structed objects. It is possible to display tracks reconstructed by the various reconstruc-
tion packages (e.g. MuonBoy, Staco, Moore, MuID, . . . ) by selecting the appropriate
objects in the window described in figure 6 (Set track parameters).

G.1 Event files from raw data

Inside ATHENA , Event files for Persint are produced by the MboyView package via
the doPersint flag in RecExCommon:

doPersint=true

It is possible to make a selection of events to be included in the Event file by using the
following parameters in the PITHON file used for running ATHENA:

# Event Selection: EvtSelectionType and EvtSelectionThreshold
# = 1 view without Selection
# = 2 view only for evts Nber of Tracks .le. EvtSelectionThreshold
# = 3 view only for evts Nber of Tracks .ge. EvtSelectionThreshold
# = 4 view only for evts Nber of Tracks .eq. EvtSelectionThreshold
# GenEvent Selection: GenEvtSelectionType and GenEvtSelectionEta<Min/Max>
# = 1 view without Selection
# = 2 view only for evts with at least a gen track with
# GenEvtSelectionEtaMin<abs(eta)<GenEvtSelectionEtaMax

if doPersint:

MboyView = Algorithm( "MboyView" )
MboyView.EvtSelectionType = 1
MboyView.EvtSelectionThreshold = 0
MboyView.GenEvtSelectionType = 2
MboyView.GenEvtSelectionEtaMin = 0.
MboyView.GenEvtSelectionEtaMax = 2.7

The information to be included in the Events for Persint can be chosen as follows (0=no;
1=yes):

if doPersint:

MboyView = Algorithm( "MboyView" )
MboyView.ViewDigits = 1 # dump the spectrometer digits
MboyView.ViewCalo = 0 # dump the calorimeter cells
MboyView.ViewMcEventCollection = 1 # dump the truth info
MboyView.ViewTrackRecordCollection = 1 # dump the TrackRecord
# (i.e. truth info at the spectrometer entrance)
MboyView.TrackRecordCollectionLocationForGenEventSelectionList =
[ "MuonEntryLayerFilter" ]
MboyView.TrackRecordCollectionLocationForGenEventSelectionList +=
[ "MuonEntryRecordFilter" ]
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G.2 Event files from ESDs or dESDs

The ASCII input file for Persint (Out.MboyView xxx) can also be produced from ESD files.

G.2.1 Procedure

• Set up ATHENA release 15.6.3 or higher. You may follow instructions given in:
https://twiki.cern.ch/twiki/bin/view/Atlas/WorkBook, in particular in sec-
tions: Getting an Account, Setting up your Account, Running Athena HelloWorld.

• Get a job options file.
A generic job options file (MboyViewESD.py) is located in the directory
Persint-00-02-••/example.
It is also available as an attachment to the following Twiki page [the file is listed
in the next section (G.2.3)]:
https://twiki.cern.ch/twiki/bin/view/Atlas/PersintDumpESD
You may want to edit the job options file for geometry and conditions tags asso-
ciated with your ESD file.

• Finally, execute the following command:
athena MboyViewESD.py -c ’inputFileList=["/path/to/ESD/file"]’
where /path/to/ESD/file is ”comme son nom l’indique”.

This will create a file MboyView which can be read by Persint.

G.2.2 Limitations

The method described above does not re-run the reconstruction but only dumps the
values already available in the ESD file. The advantage of this method is its speed.
However, in the ESD file, only the TDC counts of MDT hits are stored, and not the
radius returned by the RT calibration service.
An approximate radius is thus associated with MDT hits, in the following way:

1. If the MDT hit is associated with a Muonboy segment, the calibrated radius is
saved in the segment and this is what is returned in the ASCII dump

2. If the MDT hit is not associated with any segment, its radius is set to 7.5 mm

This last approximation makes the ASCII dump suitable for display, but not suitable
for Muonboy interactive reconstruction in Persint.

Muonboy
interactive
reconstruction

In future versions of this tool, a better radius determination may be included.

G.2.3 ATHENA job options file, an example: MboyViewESD.py

#----------------------------------------------------------------------
# Configure the input file, in a way compatible with auto-configuration
#----------------------------------------------------------------------
from AthenaCommon.AthenaCommonFlags import athenaCommonFlags
athenaCommonFlags.FilesInput = inputFileList

#----------------------------------------------------------------------
# Include the RecExCommon flags, to force trigger the auto-configuration
#----------------------------------------------------------------------
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include(’RecExCond/RecExCommon_flags.py’)

#--------------------------------------------------------------
# Load POOL support
#--------------------------------------------------------------
import AthenaPoolCnvSvc.ReadAthenaPool
from AthenaCommon.AppMgr import ServiceMgr as svcMgr
from AthenaCommon.AppMgr import ToolSvc as toolSvc

from AthenaCommon.AlgSequence import AlgSequence
topSequence = AlgSequence()

from AthenaCommon.AlgSequence import AthSequencer
selectionSequence = AthSequencer("selectionSequence")

#--------------------------------------------------------------
# Event related parameters
#--------------------------------------------------------------
# theApp.EvtMax = 100

#--------------------------------------------------------------
# GeoModel stuff
#--------------------------------------------------------------
from AthenaCommon.GlobalFlags import GlobalFlags
from AthenaCommon.DetFlags import DetFlags
DetFlags.ID_setOn()
DetFlags.Calo_setOn()
DetFlags.Muon_setOn()

# GeoModel initialisation
from AtlasGeoModel import SetGeometryVersion
from AtlasGeoModel import GeoModelInit

#--------------------------------------------------------------
# Set output level threshold (2=DEBUG, 3=INFO, 4=WARNING, 5=ERROR, 6=FATAL )
#--------------------------------------------------------------
MessageSvc = Service( "MessageSvc" )
MessageSvc.OutputLevel = 3

#-------------------------------------------------------------------------------
# Define the input collection
#-------------------------------------------------------------------------------
svcMgr.EventSelector.InputCollections = athenaCommonFlags.FilesInput()

#-------------------------------------------------------------------------------
# Optionally add to selectionSequence any private alg that selects the
# events to be dumped in Out.MboyView
#-------------------------------------------------------------------------------
# from PFMuonAnalysis.PFMuonAnalysisConf import CosmicMuonAnalysis
# selectionSequence += CosmicMuonAnalysis("CosmicMuonAnalysis")

#-------------------------------------------------------------------------------
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# Configure the MboyView algs
#-------------------------------------------------------------------------------
from MboyView.MboyViewConf import MboyViewDigiMaker
selectionSequence += MboyViewDigiMaker("MboyViewDigiMaker")
selectionSequence.MboyViewDigiMaker.ApproximateRsLine = True

from MboyView.MboyViewConf import MboyView
selectionSequence += MboyView("MboyView")
selectionSequence.MboyView.SwitchOff = 0
selectionSequence.MboyView.ViewDigits = 1
selectionSequence.MboyView.ViewTrackRecordCollection = 1
selectionSequence.MboyView.ViewCombinedMuonContainer = 1
selectionSequence.MboyView.ViewTrackParticleContainer = 1
selectionSequence.MboyView.ViewTrkTrackCollection = 1
selectionSequence.MboyView.ViewTrkSegmentCollection = 1
selectionSequence.MboyView.ViewMcEventCollection = 1
selectionSequence.MboyView.ViewEgammaContainer = 1

topSequence += selectionSequence

# AthenaEventLoopMgr = Service( "AthenaEventLoopMgr" )
# AthenaEventLoopMgr.OutputLevel = WARNING
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Logos (Add/remove), 26–28
lxplus, 14, 101

Mac OS, 12, 14, 17, 105
Magnetic field, 17, 19, 49–51, 61, 65, 70,

71, 73, 109, 110
Magnetic field (download), 71
Main display window, 17
MAT, 32
Maximize, 82
MboyViewESD.py, 150
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Simulation tracks, 23, 70
Software name, 42
Speed, 18
Spinbox, 37, 39, 140
Staco, 14
Start Persint, 15
Station, 36



155 INDEX
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Tools menu, 142
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Update release, 106
Useful hints, 96
User Manual, 145

Version number (Releases), 14, 15, 19
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Video software, 48
Visualization properties, 62, 63
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Warning messages, 147
Window menu, 144
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